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1 About this document

1.1 Other applicable documents

The information on the safety sensor is distributed over several documents to make working with the docu-
ments easier. You will find the documents and software for the safety sensor in the following table:

Purpose and target group of the document Document/software Source

title
Software for users of the machine? for safety sen- | Sensor Studio Supplied with the safety
sor diagnostics if a fault occurs and for machine RSL 400 DTM sensor on data carrier

design engineers? for configuring the safety sensor

Notes for the machine design engineer? “Safe implementation | PDF, supplied with the
and operation” safety sensor on data
(this document) carrier

Notes for the machine design engineer? for config- | Online help for soft- Supplied with the safety

uring the safety sensor (software instructions) ware sensor on data carrier

Notices regarding mounting, alignment and connec- | “Quick Start Guide Print document, supplied

tion of the safety sensor. RSL 400” with the safety sensor

a) Machine identifies the product that the safety sensor is installed in.

1.2  Downloading configuration software from Internet
% Call up the Leuze home page: www.leuze.com.
% Enter the type designation or part number of the device as the search term.
% The configuration software can be found on the product page for the device under the Downloads tab.

1.3  Used symbols and signal words

Table 1.1: Warning symbols and signal words

Symbol indicating dangers to persons

Symbol indicating dangers from harmful laser radiation

NOTICE Signal word for property damage
Indicates dangers that may result in property damage if the measures for dan-
ger avoidance are not followed.

CAUTION Signal word for minor injury
Indicates dangers that may result in minor injury if the measures for danger
avoidance are not followed.

WARNING Signal word for serious injury
Indicates dangers that may result in severe or fatal injury if the measures for
danger avoidance are not followed.

DANGER Signal word for life-threatening danger
Indicates dangers with which serious or fatal injury is imminent if the measures
for danger avoidance are not followed.

Leuze electronic RSL 410 6
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Table 1.2: Other symbols

O Symbol for tips
IL Text passages with this symbol provide you with further information.

% Symbols for action steps
Text passages with this symbol instruct you to perform actions.

Table 1.3: Terms and abbreviations

CS Switching signal from a control
(Controller Signal)

DTM Software device manager of the safety sensor
(Device Type Manager)

EDM Contactor monitoring
(External Device Monitoring)

FDT Software frame for management of device managers (DTM)
(Field Device Tool)

Field pair A protective field with an associated warning field
DTS Driverless Transportation System
LED LED, display element in the safety sensor
(Light Emitting Diode)
OSSD Safety-related switching output
(Output Signal Switching Device)
PFH, Probability of dangerous Failure per Hour
PL Performance Level
Quad Two field pairs (four fields) that are monitored simultaneously in four field mode
TSS Transverse Side-tracking Skate
RES Start/REStart interlock
SIL Safety Integrity Level
State ON: device intact, OSSDs switched on

OFF: device intact, OSSDs switched off
Locking: device, connection or control/operation faulty, OSSDs switched off
(lock-out)

1.4 Checklists

The checklists serve as a reference for the machine manufacturer or supplier (see chapter 11). They
replace neither testing of the complete machine or system prior to the initial start-up nor their periodic
testing by a competent person. The checklists contain minimum testing requirements. Depending on the
application, other tests may be necessary.

Leuze electronic RSL 410 7
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2 Safety

Before using the safety sensor, a risk assessment must be performed according to valid standards (e.g.
EN ISO 12100, EN I1SO 13849-1, IEC 61508, EN IEC 62061). The result of the risk assessment deter-
mines the required safety level of the safety sensor (see table 15.1). For mounting, operating and testing,
this document as well as all applicable national and international standards, regulations, rules and direc-
tives must be observed. Relevant and supplied documents must be observed, printed out and handed to
affected persons.

% Before working with the safety sensor, completely read and observe the documents applicable to your
task.

The following national and international legal regulations in particular apply for start-up, technical tests and
handling of safety sensors:

» Machinery Directive 2006/42/EC

» Low Voltage Directive 2006/95/EC

+ EMC Directive 2004/108/EC

» Use of Work Equipment Directive 89/655/EEC supplemented by Directive 95/63 EC

* OSHA 1910 Subpart O

» Safety regulations

+ Accident-prevention regulations and safety rules

+ Betriebssicherheitsverordnung (Ordinance on Industrial Safety and Health) and employment protec-
tion act

* Product Safety Law (ProdSG)

o  For safety-related information you may also contact the local authorities (e.g., industrial inspec-
IL torate, employer's liability insurance association, labor inspectorate, occupational safety and
health authority).

21  Approved purpose

The safety sensor protects persons or body parts at points of operation, danger zones or access points of
machines and systems.

A WARNING

A running machine may result in serious injury!

% Make certain that the safety sensor is correctly connected and that the protective function of the pro-
tective device is ensured.

% Make certain that, during all conversions, maintenance work and inspections, the system is securely
shut down and protected against being restarted.

» The safety sensor may only be used after it has been selected in accordance with the respectively
applicable instructions and relevant standards, rules and regulations regarding labor protection and
safety at work, and after it has been installed on the machine, connected, commissioned, and
checked by a competent person (see chapter 2.4).

* When selecting the safety sensor it must be ensured that its safety-related capability meets or
exceeds the required performance level PL, ascertained in the risk assessment (see table 15.1).

« With the “access guarding” function, the safety sensor detects persons only when they enter the dan-
ger zone but cannot tell whether there are any persons inside the danger zone. For this reason, a
start/restart interlock in the safety chain is essential in this case.

» The construction of the safety sensor must not be altered. When manipulating the safety sensor, the
protective function is no longer guaranteed. Manipulating the safety sensor also voids all warranty
claims against the manufacturer of the safety sensor.

» The safety sensor must be inspected regularly by a competent person to ensure proper integration
and mounting (see chapter 2.4).

» The safety sensor must be exchanged after a maximum of 20 years. Repairs or exchange of wear
parts do not lengthen the mission time.
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211

2.2

A CAUTION

Observe intended use!

% Only operate the device in accordance with its intended use.

The protection of personnel and the device cannot be guaranteed if the device is operated in a manner
not complying with its intended use.

Leuze electronic GmbH + Co. KG is not liable for damages caused by improper use.
% Read these original operating instructions before commissioning the device.
Knowledge of the original operating instructions is an element of proper use.

NOTICE
Comply with conditions and regulations!

% Observe the locally applicable legal regulations and the rules of the employer's liability insurance asso-
ciation.

Vapors, smoke, dust, particles

Vapors, smoke, dust and all particles visible in the air can cause the machine to switch off unintentionally.
This can mislead the user into bypassing the safety devices.

% Do not use the safety sensor in environments in which heavy vapors, smoke, dust or other visible par-
ticles occur at the beam level.

Stray light

Light sources can impair the safety sensor's availability. Interfering light sources are:
* Infrared light
 Fluorescent light
« Strobe light

% Ensure that there are no interfering light sources at beam level.

% Prevent reflective surfaces at beam level.

% Where applicable, take protective field addition distances into account.

% Implement all additional measures to ensure that any special application of any effected beam types
does not impair the safety sensor's operation.

Obstructions in the protective field

% Do not bring any additional window materials into the area monitored by the safety sensor.

Foreseeable misuse

Any use other than that defined under “Intended use” or which goes beyond that use is considered
improper use.

In principle, the safety sensor is not suitable as a protective device for use in the following cases:

» Danger posed by ejected objects or the spraying of hot or hazardous liquids from within the danger
zone.

» Applications in explosive or easily flammable atmospheres.

+ Use for outdoor applications or under extreme temperature fluctuations.

Humidity, condensation and other weather influences can impair the protective function.
» Use on vehicles with combustion engines.

Alternators and ignition systems can cause EMC interferences.

Leuze electronic RSL 410 9
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NOTICE
Do not modify or otherwise interfere with the device!
% Do not carry out modifications or otherwise interfere with the safety sensor.

The safety sensor must not be tampered with and must not be changed in any way.
The safety sensor must not be opened. There are no user-serviceable parts inside.

The construction of the safety sensor must not be altered. When manipulating the safety sensor, the
protective function is no longer guaranteed. Manipulating the safety sensor also voids all warranty
claims against the manufacturer of the safety sensor.

Repairs must only be performed by Leuze electronic GmbH + Co. KG.

2.3 Responsibility for safety

Manufacturer and operating company must ensure that the machine and implemented safety sensor func-
tion properly and that all affected persons are adequately informed and trained.

The type and content of all imparted information must not lead to unsafe actions by users.

The manufacturer of the machine is responsible for:
» Safe machine construction
« Safe implementation of the safety sensor, verified by the initial test performed by a competent person
* Imparting all relevant information to the operator
+ Adhering to all regulations and directives for the safe commissioning of the machine

The operator of the machine is responsible for:
* Instructing the operator
» Maintaining the safe operation of the machine
 Adhering to all regulations and directives on industrial safety and safety at work
» Regular testing by competent persons

2.4  Competent persons

Connecting, mounting, commissioning and adjustment of the safety sensor must only be carried out by
competent persons.

Prerequisites for competent persons:
» They have a suitable technical education.

» They know the rules and regulations for labor protection, safety at work and safety technology and
can assess the safety of the machine.

» They know the operating instructions for the safety sensor and the machine.

» They have been instructed by the responsible person on the mounting and operation of the machine
and of the safety sensor.

» They perform a task related to the subject matter shortly thereafter and keep their knowledge up to
date through continuous further training.

Certified electricians
Electrical work must be carried out by a certified electrician.

Due to their technical training, knowledge and experience as well as their familiarity with relevant stan-
dards and regulations, certified electricians are able to perform work on electrical systems and indepen-
dently detect possible dangers.

In Germany, certified electricians must fulfill the requirements of accident-prevention regulations BGV A3
(e.g. electrician foreman). In other countries, there are respective regulations that must be observed.

Leuze electronic RSL 410 10



# Leuze electronic Safety

2.5 Exemption of liability
Leuze electronic GmbH + Co. KG is not liable in the following cases:

» The safety sensor is not used as intended.

» Safety notices are not adhered to.

+ Reasonably foreseeable misuse is not taken into account.
Mounting and electrical connection are not properly performed.
Proper function is not tested (see chapter 11).
Changes (e.g., constructional) are made to the safety sensor.

2.6 Laser safety notices — Laser class 1 for wavelength range outside 400 - 700 nm

& ATTENTION, INVISIBLE LASER RADIATION — LASER CLASS 1

The device fulfills the IEC 60825-1:2007 (EN 60825-1:2007) requirements for a product in laser class 1

as well as the U.S. 21 CFR 1040.10 regulations with deviations corresponding to “Laser Notice No. 50”
from June 24th, 2007.

% Observe the applicable statutory and local laser protection regulations.

% The device must not be tampered with and must not be changed in any way.
There are no user-serviceable parts inside the device.
Repairs must only be performed by Leuze electronic GmbH + Co. KG.

.H. Additional measures for shielding the laser radiation are not necessary (safe for eyes).

Leuze electronic RSL 410
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3 Device description

The safety sensors from the RSL 400 series are optoelectronic, two-dimensional measuring safety laser

scanners. They satisfy the following standards:

RSL 400
Type in accordance with IEC/EN 61496 3
Category in accordance with EN ISO 13849 3
Safety Integrity Level (SIL) in accordance with IEC 61508 2
SILCL in accordance with IEC/EN 62061 2
Performance Level (PL) in accordance with EN ISO 13849-1 d

Scanner unit

Connection unit

Optics cover

Alphanumerical display (displayed
LED indicators

abwWON =

Figure 3.1: Device overview of safety laser scanner RSL 400

)
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3.1

3.11

« Laser scanner with the range class S, M, L or XL:

Range class Operating range [m]
S 3.00

M 4.5

L 6.25

XL 8.25

» 24-digit alphanumerical display
 Integrated electronic spirit level for aligning the safety sensor

* LED indicators
« Connection unit:

+ Configuration memory

All safety sensors of the RSL 410 series are equipped as follows:

» Ethernet connection for communication and configuration with the PC/laptop

» Electrical connection to the machine via M12 plug

Device overview

The following table provides an overview of the possible uses, features and functions of the RSL 400

safety sensors.

Table 3.1: Device overview

RSL 410 RSL 420 RSL 430 RSL 440
Stationary danger zone guarding X X X X
Mobile danger zone guarding X X X X
Access guarding X X X X
Point of operation guarding X X X X
Safety-related switching outputs 1 OSSD pair 1 OSSD pair | 2 OSSD pairs | 2 OSSD pairs
Protective function A X X X X
Protective function B - - X X
Signal outputs Upto3 Upto4 Upto9 Upto9
Configurable signal outputs X X X X
Number of changeover-capable 1 10 10+ 10 100
protective/warning field pairs
E-Stop linkage - X X X
Four field mode (quads) X X X X
Internal safe time delay - - X X

Protective function of RSL 400 safety sensors

The safety sensor transmits periodic light pulses via a rotating deflection unit. The light pulses are scat-
tered in all directions by obstacles, e.g. persons. A part of the light pulses is received again by the safety
sensor and evaluated. The safety sensor calculates the precise position of the object from the propagation
time of the radiated light and the current angle of the deflection unit at that time. If the object is within a
predefined area, the protective field, the safety sensor performs a safety-related switching function. It
switches the safety-related switching outputs off.

Leuze electronic
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Only when the protective field is free again does the safety sensor reset the safety-related switching func-
tion, either automatically or following acknowledgment, depending on the operating mode.

The safety sensor can even detect people when they are wearing very dark clothes, which have a very
weak diffuse reflectance.

3.1.2 Parameters for protective function

The following parameters for switching off the safety-related switching outputs of the safety sensor are
taken into consideration for the protective function:

» Configurable protective fields

» Reference contour of protective fields

Configurable field pair changeover

Selectable resolution for hand, leg or body detection

» Safety sensor response time
Selectable start-up behavior

The following non-safety-oriented functions and signals also belong to the protective function:
+ Configurable warning fields
» Configurable indication signals

Additional functions of the protective function
» Warning field evaluation
+ Selectable dynamic contactor monitoring (EDM)

3.2  Connection unit
The safety sensor is mounted, connected and aligned using the connection unit.

o ¢

i
N

M5 2x
— —
1 M12 socket, A-coded, connection to the control
2 M12 socket, D-coded, Ethernet communication connection
M5  Connection for functional earth with M5 x 10 self-cutting/self-tapping (gas tightness) and ground
strap

Figure 3.2: Device overview, connection unit

Functions of connection unit:

+ Attachment point for mounting, either directly or using an optional mounting system
When devices are swapped out, the connection unit remains mounted and aligned.

» EMC wiring for signal inputs/outputs and supply using M12 plug

Safety sensor Connection unit Connection

RSL 410 CU408-M12 M12 plug, 8-pin

Leuze electronic RSL 410 14
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» Connector bushing and EMC for the Ethernet TCP/IP communication and configuration interface to
the PC/laptop

» Memory for the configuration files and automatic parameter transfer in the event of device swap-out
* Quick-release connection to the scanner unit (see Quick Start Guide) for easy device swap-out

3.3 Display elements
The display elements of the safety sensors simplify start-up and fault analysis.

3.3.1 LED indicators
Located on the connection unit are three LEDs for displaying the operating state.

* Protective function A: LEDs 1, 2, 3

- A B——
0 a sl
1 @B == @0 v
@ ® ® ®
1 LED 1, red/green
2 LED 2, yellow
3 LED 3, blue
4 No function
5 No function
6 No function
Figure 3.3: LED indicators
Table 3.2: Meaning of the LEDs
LED Color State Description
1 Red/green OFF Device switched off
Red OSSD off
Red, flashing Error
Green OSSD on
2 Yellow OFF RES deactivated
RES activated and enabled
Blinking Protective field occupied
ON RES activated and blocked but ready to be
unlocked
Protective field free and linked sensor enabled (if
applicable)
3 Blue OFF No internal function call active (e.g. warning field
free)
ON Internal function call (e.g. warning field occupied)
Leuze electronic RSL 410 15
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3.3.2 Alphanumerical display

In normal operation, the 24-digit alphanumerical display of the safety sensor shows the monitored protec-

tive and warning field pairs. It also provides assistance during detailed fault diagnosis (see chapter 12).

Table 3.3: Alphanumerical displays
Display Description Example
Upon startup without configuration/upon initial commissioning
Sensor type Sensor type 420M

Sensor serial number

Serial number of the sensor

SN: 21513123456

Sensor name / Network
name

Name of the sensor / network

A123456789

Configuration necessary

Configuration required

CONFIG REQUESTED

Repeated until end of booting phase / start phase, then

Spirit level permanent Horizontal alignment in degrees: H H-3°V +9°
Vertical alignment in degrees: V

Upon startup with configuration

Sensor type Sensor type 410XL

Sensor serial number

Serial number of the sensor

SN: 21513123456

Sensor name / Network | Name of the sensor / network A123456789

name

IP: DHCP/FIX DHCP or permanent IP address IP: DHCP or
10.25.45.2

Bluetooth on/off

Bluetooth detection ON/OFF

Bluetooth ON

Date of configuration

Date of configuration

11/13/2014 08:15

Signature Signature of configuration DG45L82U

Spirit level Horizontal alignment in degrees: H H-3° V+9°
Vertical alignment in degrees: V

Repeated until end of booting phase / start phase, then

Display following configuration of normal operation

e.g. display of active field pair A1.1

Transfer of the configuration data

AWAITING CONFIG

Until downloading of configuration data is confirmed

DOWNLOAD CONFIG

During transfer of configuration data

Spirit level

H+/-.2V+-.°

Horizontal alignment in degrees: H
Vertical alignment in degrees: V

H-3°V +9°

Sensor detection

PING received

Display for identification by device name

PING received Device
name

Message

Leuze electronic
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Display Description Example
Message via a signal output or diagnosis 1D ProtF A: E123
Device: P007 - wrong
Config

Fault diagnosis

F... Failure, internal device error

E... Error, external error

u... Usage info, application error

... Information

P... Parameter, inconsistency in the configuration

For error diagnostics, the error's respective letter is displayed first followed by the number code. An
AutoReset is carried out after 10 seconds for errors that do not cause locking, with an unauthorized restart
being impossible. In the case of blocking errors, the voltage supply must be separated and the cause of
the error must be eliminated. Before switching on again, the steps taken before initial commissioning must
be repeated (see chapter 10).

When the protective field has been free for about 5 seconds, the device switches back to the display in
normal operation.
Displays in normal operation

The display in normal operation depends on the operating state of the safety sensor. The display can be
switched off or rotated by 180° by means of the software.

3.3.3 Field-of-view display

The upper and lower limit of the safety sensor's field of view can be displayed by means of horizontal lines
on the optics cover.

% Make sure that the safety sensor's field of view is always completely unobstructed.

NOTICE
Always check the protective field configuration!

% Check all defined protective fields each time the configuration is changed.

The field-of-view display is a comfort function and is not intended as a substitute for checking the pro-
tective field configuration.

% The safety sensor's field of view must be completely unobstructed on the application side.

3.4  Mounting system (optional)

Mounting systems and mounting brackets simplify mounting and alignment of the safety sensor. Mounting
systems and mounting brackets are available as accessories (see table 17.3).

3.5 Loop guard (optional)

The loop guard for the optics cover prevents damage to the safety sensor caused by light contact with
foreign objects. The loop guard is available as an accessory (see table 17.3).

Leuze electronic RSL 410 17
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4 Configuration and diagnostic software Sensor Studio

To start up a safety sensor in your application, the safety sensor must be set up according to its specific
use using the configuration and diagnostic software. The software is used to set up the safety configuration
of the safety sensor, to change the communication and diagnostics settings and to perform diagnostic
routines. Communication takes place via the PC.

The software is designed according to the FDT/DTM concept:

* You make the individual configurations for the safety sensor in the Device Type Manager (DTM).

» The individual DTM configurations of a project can be called up via the frame application of the Field
Device Tool (FDT).

* Each device DTM has a communication DTM that sets up and monitors the communication connec-
tions to the sensor.

O
]:L Only use the software for safety sensors manufactured by Leuze electronic.

4.1  System requirements
To use the software, you need a PC or laptop with the following specifications:

Hard disk space At least 250 MB free memory
If you want to save the protective field or configuration values, you
will need more memory.

Screen display Color

External drive DVD drive

Input device Keyboard and mouse or touchpad
Output device Printer (black-white or color)
Interfaces RJ45 Ethernet network

Bluetooth (optional) - If the PC does not have integrated Bluetooth
technology, use an appropriate USB or PCMCIA adapter if neces-
sary.

Operating system Microsoft® Windows 7 and Windows 8.1

O
.H. Only the term “PC” is used below.

4.2 Installing software

Prerequisites:
* You do not need the safety sensor to install the software on the PC.
» All Windows applications are closed.

o  The software is installed in two steps:

Il

- Install the Sensor Studio FDT frame.

- Install the LeSafetyCollection device manager (DTM).

Installing the Sensor Studio software

o |IfFDT frame software is already installed on your PC, you do not need the Sensor Studioinstal-
IL lation.

You can install the device manager (DTM) in the existing FDT frame.
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% Insert the data carrier.

The installation will start automatically.

% If installation does not start automatically, double-click the file SensorStudioSetup.exe.

% If you want to call up the menu of the CD, double-click the file start.exe.

% Select a language for the interface text in the installation wizard and software and confirm with [OK].
The installation wizard starts.

% Click [Next].

The installation wizard opens the software license agreement.

% If you want to accept the license agreement, select the appropriate option field and click [Next].

% |If the suggested installation path is OK, click [Next].

If you want to specify a different path, click the [Browse] button. Select a different path, confirm with [OK]
and click [Next].

% Click the [Install] button to start installation
The wizard installs the software and places a shortcut on the desktop ( d ).
% Click the [Finish] button to complete installation.

Installing LeSafetyCollection device manager (DTM)

Prerequisites:
» The Sensor Studio software is installed on the PC.
+ Data carrier inserted.
% Double-click the file LeSafetyCollectionSetup.exe.
% Select a language for the interface text in the installation wizard and software and confirm with [OK].
The installation wizard starts.
% Click [Next].
The installation wizard opens the software license agreement.
% If you want to accept the license agreement, select the appropriate option field and click [Next].
% If the suggested installation path is OK, click [Next].

If you want to specify a different path, click the [Browse] button. Select a different path, confirm with [OK]
and click [Next].

% Click the [Install] button to start installation.
The wizard installs the software.
% Click the [Finish] button to complete installation.

o  During installation of the software, a user admin (without password query) is created so that you

IL can start the software without user identification. If other users are registered (Tools > User man-
agement in the FDT frame menu), you must log in at the software with a user name and pass-
word.

This setting allows you to connect to the safety sensor and to read out, upload, enter or change
the safety configuration and all settings using the RSL 400 device DTM. The password for the
safety sensor only needs to be entered (i.e. the access level only needs to be changed) when
the changes are downloaded to the safety sensor (see chapter 4.5.1).
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4.3 User interface
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FDT frame menu with toolbar
RSL 400 device manager (DTM)

Figure 4.1: User interface of the software

FDT frame menu

The device managers (DTM) of the safety sensors are created and managed in the FDT frame menu.

Device manager DTM

Configuration projects for setting up the selected safety sensor are created and managed in the device

managers (DTM) of the safety sensors.
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44.2

Project tree view
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Figure 4.2: User interface with project tree view

The project tree view shows the structure of the currently installed device managers (DTM). In the project
tree view you can, for example, add copies of an already configured device manager (DTM) quickly and
easily to the DTM structure if you want to operate multiple safety sensors with the same configuration
settings.

Example: DTS with safety sensors on front and rear side

FDT frame menu

O You can find complete information on the FDT frame menu in the online help system. Select the
Help menu item in the menu [?].

Project Wizard

Using the Project Wizard you can create and change configuration projects for setting up the safety sensor
(see chapter 4.5 "Using configuration projects").

& Start the Project Wizard in the FDT frame menu by clicking the 4 button.

O Information on the Project Wizard can be found in the online help for the FDT frame menu under
Sensor Studio Options.

DTM Change

The DTM Change function makes it easier for you to call up the communication DTM of a device or change
from device DTM to communication DTM.

& Start the DTM change function in the FDT frame menu by clicking the ‘1... button.

O Information on DTM change can be found in the online help for the FDT frame menu under
Sensor Studio Options.
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443

44.4

4.5

User management
Using the user management in the FDT frame menu, you can create users, log users in/out and manage
passwords.

Creating users

When creating a user in the user management via Tools > User management in the software frame menu,
select the access level for the user. For information on access permissions and access levels (see
chapter 5.1 "Authorization concept of safety sensor").

% In the FDT frame menu, click Tools > User management > Create user.

Logging users in/out
Prerequisites:
» Users have been created
% In the FDT frame menu, click Tools > Log in/log out.

Managing passwords
Prerequisites:

» Users have been created
% In the FDT frame menu, click Tools > Change password.

o  Password management via the FDT frame menu applies to all installed device managers (DTM)
IL of the project.

Whenever write access occurs, the safety sensors of the RSL 400 series always check the
access level (Engineer, Experf) and the password defined via the device manager (DTM)
(SETTINGS > Passwords) independently of the password management via the FDT frame
menu.

Exiting Sensor Studio

When you have finished making the configuration settings, close the configuration and diagnostics soft-
ware.

& Exit the program via File > Exit.

% Save the configuration settings as a configuration project on the PC.

You can open the configuration project again at later time via File > Open or with the Sensor Studjo Project
Wizard ( & ).

Using configuration projects

Configuration projects are created and managed in the device manager (DTM) of the selected safety
sensor.

O  During installation of the software, a user admin (without password query) is created so that you

IL can start the software without user identification. If other users are registered (Tools > User man-
agement in the FDT frame menu), you must log in at the software with a user name and pass-
word.

This setting allows you to connect to the sensor and to read out, upload, enter or change the
safety configuration and all settings using the RSL 400 device DTM. The password for the sensor
only needs to be entered (i.e. the access level only needs to be changed) when the changes are
downloaded to the safety sensor (see chapter 4.5.1).

% Start the configuration and diagnostics software on the PC by double-clicking the d button.

» The mode selection of the Project Wizard is displayed.

« If the mode selection is not shown, start the Project Wizard in the FDT frame menu by clicking the
[Project Wizard] button ( 4 ).
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Figure 4.3: Project Wizard

% Select the configuration mode and click [Next].

+ Automatic connection to a connected safety sensor (Online)
» Device selection without communication connection (Offline)
* Load a saved project again
The project wizard displays the SEARCH DEVICES dialog box.
% Select the interface and click the [Start] button.

% Find the safety sensor for your configuration project using the search function of the communication
DTM.

& Leuze electronic
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FDT frame menu
Communication DTM
Device list

Search function
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Figure 4.4: Communication DTM with search function
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The project wizard displays the device list of configurable safety sensors in the SEARCH DEVICES dialog
box.
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Figure 4.5: Device selection in project wizard

% Select the safety sensor from the device selection list and click [Next].

The device manager (DTM) of the safety sensor shows the initial screen for the configuration project.
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Figure 4.6: Initial screen for safety configuration

O  The device manager (DTM) starts without querying the access level of the user. During commu-
IL nication with the safety sensor, the safety sensor does however query the access level of the
user. To change the access levels (see chapter 4.5.1 "Selecting access level").
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Setting device manager

Using the menus of the device manager (DTM) you can set the parameters of the safety configuration. The
online help system provides information on the menu items and adjustment parameters. Select the Help
menu item in the menu [?].

451 Selecting access level
Using the device manager you can change the access level of the user if necessary.
For the authorization concept of the software, see chapter 5.1 "Authorization concept of safety sensor".
% Click in the DTM menu bar on the [Change access level] button (a).
The Change access level dialog box opens.
% In the Access levellist, select the item Expert, Engineeror Observerand enter the default password or
the password defined for the individual user.
The following access levels are available:
» Observercan read everything (no password)
» Expertcan change communication and diagnostics settings (default password = comdiag)
* Engineer can additionally change the safety configuration (default password = safety)
The password is case-sensitive (i.e. a distinction is made between upper-case and lower-case letters).
% Confirm with [OK].

4.5.2 [IDENTIFICATION

Detailed information on the menu items and setting parameters can be found in the information area and
in the online help. Select the Help menu item in the menu [?].

» Safety laser scanner RSL 400
» Sensor and configuration data
+ Technical data

4.5.3 PROCESS

Detailed information on the menu items and setting parameters can be found in the information area and
in the online help. Select the Help menu item in the menu [?].

» Sensor display
Device display in the DTM menu

+ SENSOR DISPLAY
+ STATE OF THE ACTIVE PROTECTIVE AND WARNING FIELDS
+ SENSOR DATA

* Measurement contour
* Inputs / outputs

+ SENSOR DISPLAY
+ CONNECTIONS AND SIGNALS

+ Simulation — only with access level Engineer

* Measurement contour
* Inputs / outputs

454 CONFIGURATION
see chapter 9 "Configuring the safety sensor"

O You can only transfer changes made in the CONFIGURATION menu to the safety sensor if you
are logged in with the access level Engineer.
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455

4.5.6

DIAGNOSIS

Adjustment / Alignment
Display of safety sensor alignment using the integrated electronic spirit level
Prerequisites: The software and safety sensor are connected.

% In the DIAGNOSIS menu, click the [Align sensor mechanically] button ( == ).

The safety sensor display shows the horizontal and vertical alignment in degrees.
Visually identify device

If you have installed multiple safety sensors, identify the safety sensor that is connected to the currently
open device manager (DTM).

Prerequisites: The software and safety sensor are connected.
% In the DIAGNOSIS menu, click the [Visually identify sensor] button (m).

In the display of the safety sensor connected to the device manager (DTM), the message “PING received”
flashes for ten seconds.

Reset sensor
Acknowledge messages and faults
Set safety sensor to safety mode

Create and save service file

The service file contains all available information on the safety sensor as well as configuration and
settings.

When requesting support, send the service file to the Leuze electronic customer service (see chapter 14
"Service and support").

Sensor display

Device display in the DTM menu
+ SENSOR DISPLAY
« STATE OF THE ACTIVE PROTECTIVE AND WARNING FIELDS
+ SENSOR DATA

Diagnostics list

Access list

EventLog

SETTINGS

O You can only transfer changes made in the SETTINGS menu to the safety sensor if you are
logged in with the access level Engineer.

Communication
« LAN

- DHCP
« CONNECTION SETTINGS
 MAC address

» Bluetooth

+ Activate Bluetooth module
» Activate device scan
* Bluetooth address

Data telegrams

A UDP telegram can be configured which sends the status profile of the safety sensor as well as the
measurement data to a receiving device connected via Ethernet, e.g. to a PC.

EventlLog

Trigger signals output when certain events occur, are recorded and shown in the event list of the safety
sensor.
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Information on the monitored signals can be found in the information area and in the online help. Select
the Help menu item in the menu [?].

Sensor display
Activation of the safety sensor alphanumerical display.

Information on the display options can be found in the information area and in the online help. Select the
Help menu item in the menu [?].

Passwords

O Ifauser has forgotten his password for login at the safety sensor or has repeatedly entered the
IL password incorrectly, he cannot log in at the safety sensor. The CHANGE PASSWORD function
is therefore not available.

To reset the password, a user must generate a one-time password and have it confirmed by the
manufacturer.

CHANGE PASSWORD

% Define individual passwords for the access levels Engineerand Expert. These passwords replace the
default passwords set by the manufacturer.

The password is case-sensitive (i.e. a distinction is made between upper-case and lower-case letters).
One-time password

Prerequisites:

* The software is connected to the safety sensor.
% Generate a one-time password.

Note down the generated one-time password.

% Send the one-time password to the Leuze electronic customer service for confirmation (see chapter 14
"Service and support").

The device can now be switched off and the connection can be terminated.
% Enter the confirmed password and create a new password.

Optics cover

» Monitoring of optics cover

« Dialog box for calibrating a replacement optics cover
Field editor display options

Display settings for the field editor when defining protective/warning fields.
+ CONTOUR ALIGNMENT
+ COORDINATE DISPLAY
+ EDITOR BEHAVIOR

Information on the display options can be found in the information area and in the online help. Select the
Help menu item in the menu [?].
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5.1

Functions

The functions of the safety sensor must be matched to the respective application and its safety require-
ments. You can activate/deactivate the functions and adapt them using parameters. You configure the
functions with the help of the configuration and diagnostics software (see chapter 9 "Configuring the safety
sensor").

* You configure the functions of the safety sensor in the software as configuration projects.

+ In each configuration project you determine the protective function and the configurable field pairs
via the selected function mode.

» The changeover-capable protective/warning field pairs for the selected function mode are defined in
configuration banks.

* You determine the resolution, the start-up behavior, the response time and, where applicable, the
vehicle speed together for all protective/warning field pairs of a configuration bank.

Authorization concept of safety sensor

User management allows target-group-oriented communication between the software and the safety
sensor. Which functions are available depends on the selected access level of the user. For information
on the software and on user management (see chapter 4 "Configuration and diagnostic software
Sensor Studio”).

» Changing the safety configuration as well as the communication and diagnostics settings of the sen-
sor is only permitted for certain access levels.

* Installation and operation of the software do not depend on the access level of the user.

The following access levels are available:
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5.2

Table 5.1: Access levels and functions available
Access level Functions
Observer * Display the measurement contour

» Upload and display configuration data from the safety sensor
« Display status information from the safety sensor

 Display diagnostics list

» Customize display

» Display and evaluate the measurement contour

 Load configuration data from the safety sensor

 Load status information from the safety sensor

 Display diagnostics list

* Create service file

* Reset password

Expert In addition to the functions of the Observer

* Load the signed safety configuration from a file and transfer/download
to the safety sensor

» Transfer changed communication and diagnostics settings from the
PC to the safety sensor

* Print configuration data incl. protective/warning fields

* Calibrate optics cover

Engineer In addition to the functions of the Expert, full access to all user-relevant
functions and parameters:
Create and change a safety configuration:
+ Save configuration data to file
» Change all parameters of configuration
* Reset safety sensor to default values
» Define and change protective/warning fields
» Set reference contour in protective field
* Print and delete protective/warning fields
+ Load protective/warning field data from file
+ Save protective/warning field data
+ Transfer protective/warning field data from the PC to the safety sensor
» Change passwords

O The software saves individual passwords in the connected safety sensor, thereby ensuring that
only authorized users can change the existing configuration.

Determining access level

When creating a user in the user management via Tools > User management in the FDT frame menu,
select the access level for the user. In the user management you can also create and change passwords
for the users.

Using the device manager (DTM) you can change the access level of the user (see chapter 4.5.1
"Selecting access level").

* Click in the DTM menu bar on the [Change access level] button (a).

Function modes of safety sensor

You configure the functions of the safety sensor in configuration projects with the help of the configuration
and diagnostics software. In each configuration project you determine the protective function and the
configurable field pairs via the selected function mode.

You select the function mode of the safety sensor in the software device manager (DTM) with
CONFIGURATION > OSSDs (see chapter 9 "Configuring the safety sensor").

You use the protective function to define the criteria for switching off the safety-related switching outputs
(see chapter 3.1.2 "Parameters for protective function").

The changeover-capable protective and warning field pairs for the selected function mode are defined in
the configuration banks, e.g. CONFIGURATION > Protective function A > Bank A1.
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5.2.1

5.2.2

Overview of the function modes

Table 5.2: Function modes
Function mode Field pairs (FP) Field pair activation
Protective field (PF)
Warning field (WF)
One protective function 1FP/1PF+1WF Fixed selection of a field pair
One protective function - four field | 1 FP /1 PF + 3 WF Fixed selection of a field pair
mode

One protective function
A fixed field pair for safety-related switching outputs OSSD-A.

One protective function - four field mode

The safety sensor monitors one protection field and three warning fields.

Monitoring is performed together for the field pairs of protective function A and protective function B. If, for
example, the control system is monitoring field pair A1.1 for protective function A, field pair B1.1 for protec-
tive function B is also monitored.

Protective function A: protective field
Protective function B: protective field
Protective function A: warning field
Protective function B: warning field

A ON =

Figure 5.1:  Four field mode

If the protective field of protective function A is violated, safety-related switching outputs OSSD-A switch.
If the protective field of protective function B is violated, the indication signal B-CLEAR is generated — the
safety-related switching outputs do not switch.

The signals are assigned to the switching outputs via the configuration and diagnostics software
(CONFIGURATION > Outputs; see chapter 9 "Configuring the safety sensor").

Table 5.3: Example: Assignment of signals to switching outputs
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Logic signal Electrical switching output Description
OSSD A Safety-related switching outputs Protective function A: Violation of protec-
OSSD A tive field

B-CLEAR Switching output MELD - not safe Protective function B: Violation of protec-
tive field

A-WF-VIO Switching output A1 Protective function A: Violation of warn-
ing field

B-WF-VIO Switching output EA1 Protective function B: Violation of warn-
ing field

Leuze electronic
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5.3

5.4

5.5

5.6

5.6.1

Selectable resolution for hand, leg and body detection

The application-specific resolution of the safety sensor is defined in the configuration project together for
all protective/warning field pairs of a configuration bank.

Table 5.4: Resolution of the safety sensor depending on the function
Safety sensor resolution | Function Application(s)
[mm]
30 Hand detection Point of operation guarding
40 Arm detection Point of operation guarding
50 Leg detection with the safety sensor | Danger zone guarding

mounted close to floor level

60 Leg detection Danger zone guarding

* Mounting height 150 mm

* Mounting height = Height of the
scan level above floor level

70 * Leg detection with the safety sen- Stationary danger zone guarding
sor mounted at a height of Mobile danger zone guarding
300 mm

» Leg detection and detection of
lying persons in the case of
mounting on vehicles
Mounting height approx. 200 mm

150 Body detection Access guarding
Mobile side guarding

Speed-dependent protective function for vehicles

For object detection in the case of mobile applications, the safety sensor evaluates the relative speed of
the object. If the safety sensor is mounted on vehicles or on moving parts of machines, the maximum
speed of the vehicle must be entered during configuration of the protective function.

The maximum vehicle speed (Max. DTS speed) is selected in the configuration project together for all
protective/warning field pairs of a configuration bank.

Response time

The response time is the maximum time from a protective field violation to switch-off of the safety-related
switching outputs.

The response time is selected in the configuration project together for all protective/warning field pairs of
a configuration bank.

Configurable start-up behavior

The start-up behavior is selected in the configuration project together for all protective/warning field pairs
of a configuration bank.

Automatic start/restart

The machine starts automatically as soon as the machine is switched on or the supply voltage returns and
when the protective field is free again.

Using automatic start/restart

You can use the aufomatic start/restart function under the following prerequisites:

» The start/restart interlock function is taken over by a downstream safety-related component of the
machine control system.
or

* It is not possible to walk behind or go around the effective protective field.
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% Allow for an optical and/or acoustic start warning.

Automatic start-up
The aufomatic start-up function starts the machine automatically as soon as the supply voltage is present.

Automatic restart
The aufomatic restartfunction starts the machine automatically as soon as the protective field is free again.

5.6.2 Start interlock/automatic restart

With start interlock/automatic restart, the safety sensor remains in the OFF state when, following a power
supply interruption, the voltage supply is restored. After violation of the protective field, the system restarts
when the protective field is free again.

The start/restart interlock has two functions:
 Start interlock
¢ Automatic restart

Using start interlock/automatic restart

% In addition to the safety sensor you must also install the reset button. The machine operator starts the
machine with this reset button.

% Position the reset button outside the danger zone so that it cannot be activated from the protective fields
and danger zones. The operator must be able to see all danger zones from this position.

% Identify the area to be released on the reset button so that its meaning is clear and easy to understand.
% Ensure that nobody is in the danger zone before pressing the reset button.
% Hold down the reset button for between 0.12 s and 4 s to enable the safety-related switching outputs.

A DANGER

Risk of death if start-up is operated unintentionally!
% Ensure that the reset button for unlocking the start interlock cannot be reached from the danger zone.

% Before unlocking the start interlock, make certain that no people are in the danger zone.

Start interlock

The start interlock function prevents the machine from starting automatically after switching on or after the
supply voltage returns.

The machine only starts when you press the reset button.

Automatic restart
The aufomatic restartfunction starts the machine automatically as soon as the protective field is free again.

5.6.3 Start/restart interlock (RES)

When accessing the protective field, the start/restart interlock ensures that the safety sensor remains in
the OFF state after the protective field has been cleared. It prevents automatic release of the safety circuits
and automatic start-up of the system, e.qg. if the protective field is again clear or if an interruption in the
voltage supply is restored.

The start/restart interlock has two functions:
« Start interlock
* Restart interlock

o  Foraccess guarding, the start/restart interlock function is mandatory. The protective device may
IL only be operated without start/restart interlock in certain exceptional cases and under certain
conditions acc. to ISO 12100.

Using start/restart interlock

% In addition to the safety sensor you must also install the reset button. The machine operator starts the
machine with this reset button.
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5.7

5.8

% Position the reset button outside the danger zone so that it cannot be activated from the protective fields
and danger zones. The operator must be able to see all danger zones from this position.

% |dentify the area to be released on the reset button so that its meaning is clear and easy to understand.
% Ensure that nobody is in the danger zone before pressing the reset button.
% Hold down the reset button for between 0.12 s and 4 s to enable the safety-related switching outputs.

A DANGER

Risk of death if start/restart is operated unintentionally!

% Ensure that the reset button for unlocking the start/restart interlock cannot be reached from the danger
zone.

& Before unlocking the start/restart interlock, make certain that no people are in the danger zone.

Start interlock

The start interlock function prevents the machine from starting automatically after switching on or after the
supply voltage returns.

The machine only starts when you press the reset button.

Restart interlock

The restart inferlock function prevents the machine from starting automatically, as soon as the protective
field is free again. The resfart interlock function always includes the start interlock function.

The machine only starts again when you press the reset button.

Reference contour monitoring

The reference contour monitoring function prevents unintentional misalignment and deliberate manipula-
tion of the safety sensor. If a protective field contains an area with reference contour, the safety sensor not
only monitors interruptions of the protective field, it also monitors the concurrence of the measured area
contour with the set reference contour. If the measurement values of the area contour deviate from the
defined reference contour by more than the tolerance zone of 200 mm, i.e., if no object is detected in the
area with reference contour, the safety sensor switches off and the safety-related switching outputs
(OSSDs) switch to off.

Activation of the function

% Activate the Reference confour monitoring function together with the definition of the protective field
boundaries using the configuration and diagnostics software (see chapter 9.4.4 "Creating and configur-
ing protective/warning field pairs").

Standby request

EDM contactor monitoring

The EDM contactor monitoring function dynamically monitors the contactors, relays or valves connected
downstream of the safety sensor. Prerequisites for this are switching elements with positive-guided feed-
back contacts (normally closed contact).

Activation of the function

% Activate the contactor monitoring function using the configuration and diagnostics software (see
chapter 9.4 "Configuring protective function").

If contactor monitoring is activated, it operates dynamically, i.e., in addition to monitoring the closed feed-

back circuit every time before the OSSDs are switched on, it also checks whether the feedback circuit has

opened within 500 ms after release and whether it has closed again within 500 ms after the OSSDs

switched off. If this is not the case, the OSSDs return to the OFF state after being switched on briefly.

A message is displayed on the alphanumerical display and the safety sensor switches to the fault interlock

state:

» With the OSSDs switched off, +24 VV must be present at the EDM input.
+ With the OSSDs switched on, the EDM circuit must be open (high impedance).
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6.1

6.2

Applications
The following chapters essentially describe the safety sensor's usage possibilities.

» To safely mount the safety sensor for the respective application, see chapter 7 "Mounting".
* For the electrical connection of the safety sensor, see chapter 8 "Electrical connection".

» To safely configure the safety sensor for the respective application, see chapter 9 "Configuring the
safety sensor".

Stationary danger zone guarding

Stationary danger zone guarding enables a very spacious protection of people on machines that are to
remain as accessible as much as possible. The safety sensor is applied as a stop-activating and presence-
detecting protective device. The safety sensor's protective field is set up horizontally in front of the machine
or system's point of operation.

You can also use the stationary danger zone guarding if you do have to guard areas under the machine
or at the rear that are not visible.

If the danger zone changes during operation, the respective danger zone is guarded by means of a field
pair changeover while the working area is accessible.

1 Safety sensor
2 Danger zone, protective function activated

Figure 6.1:  Stationary danger zone guarding

Stationary point of operation guarding

Hand and arm protection are always required when people must work at the point of operation. The safety
sensor is applied as a stop-activating and presence-detecting protective device. The safety sensor's
protective field is set up vertically in front of the machine or system's point of operation. In accordance with
EN ISO 13855, resolutions from 14 to 40 mm make sense here. This yields the necessary safety distance
for finger protection, among others (see chapter 7.3 "Stationary point of operation guarding").
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6.3

6.4

Stationary access guarding

Stationary access guarding protects people that step into a danger zone. The vertically aligned protective
field of the safety sensor detects the passage of a person. A side post and the floor serve as reference
contour for monitoring the position of the protective field. In contrast to danger zone guarding, the safety
sensor no longer registers a person in the danger zone after the passage. This is why the sfart/restart infer-
lock function is vital for access guarding.

Safety sensor
Reference contour

1

2

3 Danger zone 1, protective function activated

4 Danger zone 2, protective function deactivated

Figure 6.2: Stationary access guarding

Mobile danger zone guarding

Mobile danger zone guarding protects people that are located in the transportation path of a driverless
transportation system (DTS). The distance between the protective field front edge and the vehicle front
must be greater than the stopping distance of the vehicle with selected speed and maximum load. A safe
control system selects speed-dependent protective fields and can activate side horizontal protective fields
for curved stretches.
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Warning field for forward travel

Protective field 1 for forward travel, deactivated
Protective field 2 for forward travel, activated
Protective field 1 for reverse travel, activated
Protective field 2 for reverse travel, deactivated
Warning field for reverse travel

Figure 6.3: Mobile danger zone guarding

DO WN -
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Warning field for forward travel

Protective field 1 for forward travel, deactivated
Protective field 2 for forward travel, activated
Protective field 1 for reverse travel, activated
Protective field 2 for reverse travel, deactivated
Warning field for reverse travel

1
2
3
4
5
6

Figure 6.4: Mobile danger zone guarding

6.5 Danger zone guarding on side-tracking skates

Side-tracking skate guarding

Side-tracking skate guarding protects personnel who are located in the transportation path of a transverse
side-tracking skate (TSS). One safety sensor is mounted in each direction of travel. The safety sensor that
is mounted opposite the current direction of travel is deactivated. Evaluation of the warning field allows the
transverse side-tracking skate to be braked gently. To ensure optimum material transport, the control
changes over the protective/warning field pair depending on the state and speed.

Mobile side guarding

Mobile side guarding protects people and objects that are located on the vehicles path. This application is
used when very low arranged roller conveyors do not permit an unobstructed passage of horizontal, lateral
protrude protective fields. The safety sensors are positioned laterally and the protective fields are arranged
vertically, at a slight tilt. The position of the front edges of the side protective fields is oriented here on the
position of the front edge of the horizontal protective field.
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Protective and warning field pair for forward travel, activated
Protective and warning field pair for side guarding, left, activated
Protective and warning field pair for side guarding, right, activated
Protective and warning field pair for reverse travel, deactivated

1
2
3
4

Figure 6.5: Mobile side guarding on side-tracking skates
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7 Mounting

The safety sensor's protective function is only guaranteed when the device arrangement, configuration,
protective field dimensioning and mounting are coordinated with the respective application.

The installation work must only be performed by a competent person in compliance with the applicable
standards and these instructions. The mounting must be thoroughly inspected on completion.

% You must observe and comply with the respective relevant machine-specific standards and regulations
(see chapter 16 "Standards and legal regulations").

% Observe the basic information on mounting (see chapter 7.1 "Basic infos").

A WARNING

Improper mounting may result in serious injury!

The protective function of the safety sensor is only ensured if appropriately and professionally mounted
for the respective, intended area of application.

% Only allow competent persons to install the safety sensor.
% Maintain the necessary safety distances (see chapter 7.1.1 "Calculation of safety distance S").

% Make sure that stepping behind, crawling under or stepping over the protective device is reliably ruled
out and reaching under, over or around is taken into account in the safety distance, if applicable with
additional distance Cy, corresponding to EN ISO 13855.

% Take measures to prevent that the safety sensor can be used to gain access to the danger zone, e.g.
by stepping or climbing into it.

% Observe the relevant standards, regulations and these instructions.
% After mounting, check the safety sensor for proper function.
% Clean the safety sensor at regular intervals.

Environmental conditions: see chapter 15 "Technical data"

Care: see chapter 13 "Care, maintenance and disposal"

7.1 Basic infos

7.1.1 Calculation of safety distance S

Optical protective devices can only perform their protective function if they are mounted with adequate
safety distance. When mounting, all delay times must be taken into account, such as the response times
of the safety sensor and control elements as well as the stopping time of the machine, among others.

The following standards specify calculation formulas:

» EN ISO 13855, "Safety of machines - The positioning of protective device in respect of approach
speeds of parts of the human body": mounting situation and safety distances

General formula for calculating the safety distance S of an Optoelectronic Protective Device acc. to

EN ISO 13855:
S=K-T+C
S [mm] = Safety distance
K [mm/s] = Approach speed
T [s] = Total time of the delay, sum from (t, + t, + t,)
t. [s] = Response time of the protective device
t [s] = Response time of the safety relay
tn [s] = Machine stopping time
C [mm] = Additional distance to the safety distance

O If longer stopping times are determined during regular inspections, an appropriate additional time
must be added to t,.
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7.1.2 Suitable mounting locations

Area of application: Mounting
Tester: technician who mounts the safety sensor

Table 7.1: Checklist for mounting preparations

Check: Yes No

Is the safety distance to the point of operation maintained?

Has the scanning angle of the safety sensor as given on the marking/template on the top
of the sensor been taken into consideration?

Can the point of operation or the danger zone only be accessed through the protective
field?

Have measures been taken to prevent the protective field from being bypassed by crawl-
ing under?

Is stepping behind the protective device prevented or is mechanical protection available?

Can the safety sensors be fastened in such a way that they cannot be moved and
turned?

Is the safety sensor accessible for testing and replacing?

Is it impossible to actuate the reset button from within the danger zone?

Can the entire danger zone be seen from the installation site of the reset button?

O Ifyou answer one of the items on the checklist (see table 7.1) with 770, the mounting location must
be changed.

7.1.3 Mounting the safety sensor

O Detailed information on mounting the safety sensor can be found in the document “Quick Start
Guide RSL 400"

Proceed as follows:

% Calculate the necessary safety distance and determine the required additional distances for your appli-
cation.

% Determine the mounting location.
» Observe the information regarding the mounting locations; see chapter 7.1.2 "Suitable mounting
locations".
» Ensure that machine parts, safety guards or covers do not impair the safety sensor's field of vision.

» Make sure that the scanning range of the safety sensor is not limited. To mount the safety sensor
taking the scanning range into consideration, a template must be attached to the top cover of the
safety sensor.
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all dimensions in mm

Safety sensor

Template (markings on safety sensor)

Mounting location

Reference point for distance measurement and protective field radius
Area with unobstructed view; must remain free

Figure 7.1:  Mounting taking the scanning range of 270° into consideration
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all dimensions in mm
1 Scan level
2 Area with unobstructed view; must remain free (40 mm)

Figure 7.2: Mounting: area with unobstructed view

% Determine whether you are going to install the safety sensor with or without the mounting system.

During mounting, use the four supplied M5 screws or four similar screws with a diameter of 5 mm, and
make certain that the mounting elements or mounting construction supports at least four times the
weight of the device with or without mounting system.

% Have the appropriate tools at the ready and mount the safety sensor.
% Install protective enclosures or safety bars if the safety sensor is in an exposed position.
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% If there is a risk that the safety sensor will be used as a climbing aid, install a suitable physical cover
over the safety sensor.

% Align the mounted safety sensor horizontally and vertically using the integrated electronic spirit level.

 For the electronic spirit level to work, the supply voltage of 24 V must be present at the safety sensor.
» The electronic spirit level indicates the vertical (V) and horizontal (H) alignment of the safety sensor.
The spirit level is displayed
» permanently after the end of the booting phase/start phase when starting without configuration
+ repeatedly until the end of the booting phase/start phase when starting with configuration
» using the configuration and diagnostics software:
Diagnosis > [Align sensor mechanically] button ( =)

* When mounting without a mounting system, the safety sensor can be aligned only slightly along the
horizontal axis.

% Attach safety notice stickers to the mounted safety sensor (the stickers are included in the delivery con-
tents).

% Configure the safety sensor with the configuration and diagnostics software; see chapter 9 "Configuring
the safety sensor":
» Observe the information on the response times, the stopping time of the machine and the protective
field dimensioning for your application.

» Determine the size of the protective field on the basis of the mounting location, the calculated safety
distances and additional distances.

» Configure the protective field so that the safety-related switching outputs are switched off from every
accessible point with sufficient minimum distance D.

« Determine the start-up/restart operating mode required for the application.
* If you are using start and/or restart interlock, determine the position for the reset button.

« Many safety-relevant parameters are preset for each application in the configuration and diagnostics
software. Use these preset values where possible.

% Create a record document for the device configuration and protective field dimensioning.
» The document must be signed by the person responsible for the configuration.
* Include this document with the machine documentation.

% Mark the protective field boundaries on the floor.
You can easily test the safety sensor along this marking.

After mounting, you can electrically connect (see chapter 8 "Electrical connection"), start up, align (see
chapter 10 "Starting up the device"), and check (see chapter 11 "Testing") the safety sensor.
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7.1.4 Mounting examples
54,6
all dimensions in mm
1 Safety sensor
2 Post
3 Mounting bracket BT856M
Figure 7.3: Example: mounting on a post
40
T / \ N
4
m
o
<
all dimensions in mm
1 Safety sensor
2 Mounting bracket BT840M
Figure 7.4: Example: mounting on a chamfered corner
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Mounting bracket BTF815M (only in combination with the mounting system BTU800M)
Mounting system BTU800M

1

2

3 Safety sensor
5:

Figure 7. Example: mounting on floor

Information on protective field dimensioning

% Dimension the protective field big enough that the safety sensor's switching signal can stop the danger-
ous movement in good time.

If several protective fields are selected with field pair changeover, this condition applies for all protective
fields.

Protective fields with a radius of less than 200 mm (safety sensor short range) are not permitted and
are therefore preset as minimum contour.

% If you cannot sufficiently dimension a protective field, use additional protective measures, e.g. safety
guards.

% Ensure that the protective field cannot be walked behind in the direction of the danger zone.

% Observe all delay times, e.g. safety sensor response times, control element response times, braking
times or machine or driverless transportation system stopping times (DTS).

% Take changed delay times, which, for example, can be caused by reducing the braking force, into
account.

% Observe shadowing effects, e.g. surfaces and areas behind static objects. People in the shadows of
these objects will not be detected by the safety sensor.

% Observe the lateral tolerance when dimensioning the protective fields (see chapter 15 "Technical data").
% Do not use cone-shaped protective field contours, as these do not guarantee any protective function.
% Take the additional distances required for the application into account.

Handling unmonitored areas

There is an area behind the safety sensor that the safety sensor does not monitor. Unmonitored areas can
also materialize, e.g. if you install a safety sensor on a rounded off vehicle front.

It must not be possible to walk behind unmonitored areas.
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Safety sensor

Protective field

Unmonitored area;

optimum availability at a distance of 50 mm to fixed contours

WN =

Figure 7.6:  Unmonitored area

% Prevent access to an unmonitored area with screens.
% Prevent walking behind by countersinking the safety sensor into the machine contour.

Countersinking into the machine contour, min. 100 mm
Minimum distance above the scanner unit, min. 34 mm
Protective field

Safety sensor

Machine

Angled physical cover

OO WN -

Figure 7.7:  Stepping behind protection by countersinking into the machine contour

% Use a physical cover set at an angle over the safety sensor if you expect that the safety sensor will be
used as a climbing aid or standing surface.
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Protective field setup with adjacent safety sensors

The safety sensor has been developed in a way that prevents several safety sensors from interfering with
one another as much as possible. Nevertheless, if several safety sensors are positioned adjacent to each
other, this may result in a reduction in the availability of the safety sensors.

% Plan for shielding with stationary applications.

The shielding must be at least as high as the safety sensor's optics cover and embedded with the front
housing edge.

If you plan for a shielding that is still within the countersinking in the machine contour, the resolution of
the protective fields must not be impaired at any accessible points.

You require the reciprocal shielding with both horizontal and vertical alignment of the protective fields.

1 Point of operation

2 Safety sensor

3 Machine with countersinking for sensor installation
4 Protective fields

5 Shielding

Figure 7.8: Shielding prevents reciprocal influencing of safety sensors set up beside one another

% Install the safety sensors off-set on the height.

1 Minimum distance, min. 100 mm
2 Scan level

Figure 7.9: Height offset mounting, parallel alignment

% Install the safety sensors with crossed alignment.
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7.2

1 Scan level
Figure 7.10: Mounting beside one another, without height offset, crossed alignment

1 Scan level

Figure 7.11: Mutually opposing mounting, without height offset, crossed alignment

Stationary danger zone guarding
The safety sensor takes over the stop-activating and presence-detecting function.

Calculation of safety distance S for parallel approach to the protective field

S=K-T+C

S [mm] = Safety distance

K [mm/s] = Approach speed for danger zone guarding with approach direction parallel to the pro-
tective field (resolution up to 90 mm): 1600 mm/s

T [s] = Total time of the delay, sum from (t, + t, + t,))

t. [s] = Response time of the protective device

t [s] = Response time of the safety relay

tm [s] = Machine stopping time

C [mm] = Additional distance for danger zone guarding with approach reaction H = height of the

protective field, H,,, = minimum installation height permitted, but no smaller than 0,
d = resolution of the protective device C = 1200 mm-0.4 - H; H,,, = 15 - (d - 50)

Response times, stopping time of the machine

The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. At least
two consecutive scans must be interrupted so that the safety-related switching outputs switch off. The
safety sensor's minimum response time is therefore 80 ms.

If you want to increase the safety sensor's availability in an environment with fine particles, increase the
number of interrupted scans after which the safety-related switching outputs switch off. With each addi-
tional scan the response time t, increases by 40 ms. With K = 1600 mm/s the safety distance increases by
64 mm per additional scan.

% Select a response time t, of at least 120 ms or higher.
% Determine the machine/system's stopping time t,.

If data is not available, you can commission Leuze electronic to perform measurements; see chapter 14
"Service and support".

% If an increase in the stopping time within the regular test periods is to be expected, take an additional
time into account for the machine's stopping time t,.
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Additional distance C for danger zone guarding with approach reaction
You prevent reaching the point of operation by reaching over with the additional distance C:

C =1200-0,4-H

H [mm] = Height of protective field above floor (installation height)
Cun  [mm] =850 mm
Huax  [mm] =1000 mm

The minimum permissible installation height depends on the resolution of the safety sensor:

Table 7.2: Additional distance C depending on the resolution of the safety sensor
Safety sensor resolution (mm) Minimum permissible installa- | Additional distance C (mm)
tion height (mm)
50 0 1200
60 150 1140
70 300 1080

Application-related additional distances for safety distance S

The protective field boundaries must be defined so that the calculated safety distance S to the point of
operation, extended by the additional distances, is complied with everywhere. Where this is not possible
or does not make sense, you can use hard guards as supplementary measures.

Routing machine with free space for sensor protective field in the area under the machine table
Safety sensor
Protective field contour
Warning field contour
Calculated safety distance S
Minimum distance D (= safety distance S + additional distance Zg,, + Z, where required)
G Largest protective field radius without additional distances, measured from the rotation axis of the
rotary mirror

TOWDWN =

Figure 7.12: Defining the protective field contour for a stationary, horizontal protective field

% Define the limits of the protective field using the safety distance S without an additional distance.
% Determine the biggest protective field radius R; for this protective field.
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7.3

The biggest protective field radius determines the additional distance Z, for the system-related mea-
surement error, by which the protective field contour must be enlarged.

The position of the rotary mirror's center point with regard to the housing is provided by the dimensioned
drawings.

Table 7.3: Additional distance Z, for the protective field contour because of measurement error
Biggest protective field radius R, without additional Additional
distances distance Z,
<6.25m 100 mm
>6.25m 120 mm

% Avoid retro-reflectors at the beam level beyond the protective field boundaries. If this is not possible,
add another additional distance Zx.,, of 100 mm.

Minimum distance D to the protective field contour
The minimum distance D is the distance between point of operation and protective field contour.

D = S+Zgy+ZrerL

D [mm] = Minimum distance between the point of operation and the protective field contour
Zgy  [mm] = Additional distance for system-related measurement error
Zegre  [mm] = Additional distance for retro-reflectors

% If the protective field runs up against fixed boundaries, such as walls or machine frames, take a coun-
tersinking into the machine contour of at least the size of the necessary additional distance Z,,, and Zx,
where required, into account. With the protective field contour under these conditions, stay about 50 mm
away from the machine surface.

% If the protective field runs up against hard guards, ensure that the protective field ends under instead of
in front of the hard guards. The width of the lower post must correspond with the size of the required
additional distances.

% If all hazards in the fenced off area are covered by the safety sensor and the height of the beam level
is 300 mm, you can raise the bottom edge of the hard guards from 200 mm to 350 mm. The protective
field reaching to under the hard guards takes over the protective function of preventing an adult from
crawling under in this case.

O
J:L The beam level of the safety sensor is level with the alphanumerical display.

% Prevent obstructions within the calculated protective field boundaries. If this is not possible, implement
protective measures so that the point of operation cannot be reached from out of the shadow of the
obstruction.

Stationary point of operation guarding
The safety sensor takes over the stop-activating and presence-detecting function.
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Calculation of safety distance Sy, for access over the vertical protective field
Sro = K- T+Cgrg

Sro  [mm] = Safety distance

K [mm/s] = Approach speed for point of operation guarding with approach reaction and normal
approach direction to the protective field (resolution 14 to 40 mm): 2000 mm/s
or 1600 mm/s, when Sz, > 500 mm

T [s] = Total time of the delay, sum from (t, + t + t,)

t, [s] = Response time of the protective device

t [s] = Response time of the safety relay

tn [s] = Machine stopping time

Cro [mm] = Additional distance in which a body part can move towards the protective device before

the protective device triggers.

Response times, stopping time of the machine

The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. With each
additional scan the response time t, increases by 40 ms. With K = 2000 mm/s approach speed this corre-
sponds with an increase in the safety distance of 80 mm per additional scan. With K = 1600 mm/s it is
64 mm.

% Select a response time t, of at least 80 ms or higher.
% Determine the machine/system's stopping time t,.

If data is not available, you can commission Leuze electronic to perform measurements (see chapter 14
"Service and support").

% If an increase in the stopping time within the regular test periods is to be expected, take an additional
time into account for the machine's stopping time t,.

Additional distance C, for finger protection
The required finger protection is ensured here by an additional distance C, which depends on the safety
sensor resolution, in addition to the safety distance.
+ Detection of an adult's hand:
* Resolution: 30 mm
+ Additional distance Cg,: 128 mm
* Arm detection:

* Resolution: 40 mm
« Additional distance Cg,: 208 mm

Protective field contour and reference contour

With a vertical protective field, you must define at least two sides of the protective field contour as refer-
ence contour. The objective is to monitor the position of the protective field with regard to its marginal area.
If the arrangement misaligns and the distance of the safety sensor to the reference surface changes as a
result, switch the safety-related switching outputs off.
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Physical frame for reference contour

Reference contour, must cover at least two sides of the protective field

Safety sensor

Distance e between the reference contour frame and machine opening, recommended: e = 150 mm
Machine opening contour

A ON =

Figure 7.13: Defining the protective field contour and reference contour, stationary point of operation
guarding, vertical protective field

7.4  Stationary access guarding

The vertical protective field used for access guarding only detects people during passage through. After a
person has passed through, a start/restart interlock must ensure that the dangerous movement does not
start again automatically.

Calculation of safety distance S, for access guarding
Spr = K- T+Cgy

Skr [mm] = Safety distance

K [mm/s] = Approach speed for access guarding with approach direction orthogonal to the protec-
tive field: 2000 mm/s or 1600 mm/s, if Sg; > 500 mm

T [s] = Total time of the delay, sum from (t, + t + t,)

t, [s] = Response time of the protective device, max. 80 ms

t [s] = Response time of the safety relay

tm [s] = Machine stopping time

Cerr  [mm] = Additional distance for access guarding with approach reaction with resolutions of

14 to 40 mm, d = resolution of protective device Cg; = 8 - (d - 14) mm. Additional dis-
tance for access guarding for resolutions > 40 mm: Cg; = 850 mm (standard value for
arm length)

Response times, stopping time of the machine

The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. With each
additional scan the response time t, increases by 40 ms. With K = 2000 mm/s approach speed this corre-
sponds with an increase in the safety distance of 80 mm per additional scan. With K = 1600 mm/s it is
64 mm.

% Select a response time t, of 80 ms or higher.

Never define a value higher than 80 ms for t, for access guarding or passage controls. With higher val-
ues it can happen that a person might not be detected when passing through the protective field with
an approach speed of 1600 mm/s.

% Determine the machine/system's stopping time t,.

If data is not available, you can commission Leuze electronic to perform measurements (see chapter 14
"Service and support").
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7.5

7.51

% If an increase in the stopping time within the regular test periods is to be expected, take an additional
time into account for the machine's stopping time t,,.

Additional distance C; for finger protection
The required finger protection is ensured here by an additional distance C, which depends on the safety

sensor resolution, in addition to the safety distance.
+ Detection of an adult's hand:

* Resolution: 30 mm
» Additional distance Cg;: 128 mm
* Arm detection:

* Resolution: 40 mm
« Additional distance Cg;: 208 mm

Protective field contour and reference contour

With a vertical protective field, you must define at least two sides of the protective field contour as refer-
ence contour. The objective is to monitor the position of the protective field with regard to its marginal area.
If the arrangement misaligns and the distance of the safety sensor to the reference surface changes as a
result, switch the safety-related switching outputs off.

% When defining the protective field ensure that there are no gaps bigger than 150 mm.

% When defining the protective field boundaries,
specify the sectors that monitor the position of the protective field as reference contour.

Mobile danger zone guarding on DTSs

Danger zone guarding protects people and objects that are in rooms in which vehicles move in, e.g. auto-
mated guided vehicle systems (DTSs).

A horizontally arranged protective field protects people and objects that are in the vehicle's path and are
detected by the front edge of the protective field.

A WARNING

Danger of injury because of insufficient vehicle stopping distance

% The operator of the machine must use organizing measures to prevent people from entering the pro-
tective field of the vehicle from the sides or being able to move towards an approaching vehicle.

% Only use the safety sensor on vehicles with electrical drive and electrically influenced drive and braking
devices.

% Only install the safety sensor on the front of the vehicle.
If you must also guard the reverse travel, you must also install a safety sensor on the rear of the vehicle.

% Mount the safety sensor on the vehicle so that there are no unmonitored areas = 70 mm between the
protective field and vehicle front.

% Set the mounting height such that the beam level is not more than 200 mm above the floor.

A person lying on the floor can therefore be safely detected. This is required by the C standard, EN 1525
"Safety of industrial trucks — Driverless corridor supply vehicles and their systems".

O
.H. The beam level of the safety sensor is level with the alphanumerical display.

Minimum distance D

D = Dp+Zges
D [mm] = Minimum distance, vehicle front (danger) to protective field front edge
D, [mm] = Stopping distance
Zior  [mm] = Total required additional distances
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Figure 7.14: Mobile danger zone guarding, calculation of required minimum distance D
Stopping distance D,
Dp = Vimax  (T1+To)+Dg-Ly- Ly

D, [mm] = Stopping distance

Vimax  IMM/s] = Maximum vehicle speed

T, [s] = Safety sensor response time

T, [s] = DTS response time

Dg [mm] = Braking distance with v,,., and maximum vehicle load

L, [---] = Factor for brake wear and tear

L, [--] = Factor for problematic floor conditions, e.g. dirt, wet conditions
Additional distances Z

Ziot = Zgm+ZF + ZRerL

Lo [mm] = Total of the required additional distances

Zsy [mm] = Additional distance for system-related measurement error, see table 7.3

Ze [mm] = Additional distance required with lack of floor space H:

Zegre  [mm] = Additional distance required with retro-reflectors beyond the protective field boundar-

ies; Zger, = 100 mm

The additional distance Z, is always required. Its size depends on the biggest radius R; from the safety

sensor mirror's rotary axis to the protective field boundary without Z;,.. The position of the rotary mirror axis

depends on the installation situation.

The additional distance Z: is required if the vehicle does not have enough free floor space H: and there is

therefore no space under the vehicle or the safety sensor for the tips of the feet. You determine the addi-

tional distance Z; according to the following diagram:
H

F
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80 ~J
60
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20 40 60 80 100120 140 160

Figure 7.15: Diagram for determining the additional distance Z; with lack of floor space H:
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If wheels are mounted near the side wall, always add an additional distance Z: > 150 mm.

7.5.2 Protective field dimensions

7.6

i
(O]
N
D ZGES__

D Minimum distance, vehicle front (danger) to protective field front edge

D, Stopping distance

Zro Total required additional distances to the front and for both sides

F. Distance from safety sensor center to left vehicle edge

Fr Distance from safety sensor center to right vehicle edge

Rs Biggest radius in the protective field without Z.,; for determining the additional distance Zs,

Figure 7.16: Mobile danger zone guarding, dimensions for horizontal protective field

% Select 70 mm resolution.

% Set the protective field length so that the response time until braking and the braking distance, including
factors for wear and tear and floor conditions, and any necessary additional distances are taken into
account.

% Arrange the protective field symmetrically with reference to the vehicle width, even if the safety sensor
is not arranged centered.

% Configure an upstream warning field that reduces the vehicle's speed.

A full brake with a subsequent interruption of the protective field is then executed moderately and is less
demanding on the vehicle's drives.

Dimension the minimum distance D for the maximum speed as if the speed reduction initiated by the
warning field had not happened.

% Take the required free space for lateral protrude protective fields under the roller conveyors along the
transportation path into account.

% If you have to expect angular deviations of the vehicle during the travel, plan an additional tolerance
area to guarantee undisturbed travel operation.

Mobile side guarding on DTSs

A WARNING

Danger of injury because of insufficient vehicle stopping distance

% The operator of the machine must use organizing measures to ensure that people cannot enter the
vehicle's protective field from the side.

% For mobile vertical protective fields use a resolution of at least 150 mm.

% Position the protective field edges in the travel direction in accordance with the front protective field edge
of the horizontal protective field.
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7.7

7.71

% Ensure that the response time of all components of the switch-off circuit are the same or balance the
response times with different protective field dimensioning.

% Set the vertical protective fields at a slight angle so that the lower protective field edges protrude over
the vehicle width by the amount of the additional distances, Z,, Z- and Z.., where required; see
figure 7.16.

Mounting accessories

Mounting system

Using the mounting system you can adjust the safety sensor horizontally and vertically by +10 degrees
when mounting.

Figure 7.17: Mounting system BTU8800M

NOTICE
Floor mounting only with mounting system BTUS800M

% The mounting system BTU800M must be used in the case of installation using the mounting bracket
for floor mounting.

% Install the wall mount or mounting bracket for floor mounting on the system side.
% Mount the mounting system on the wall mount or on the mounting bracket for floor mounting.
% Attach the safety sensor to the mounting system.
Tightening the screws fixes the safety sensor in position.
% Align the safety sensor using the integrated electronic spirit level.
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7.7.2 Loop guard

The loop guard for the optics cover prevents damage to the safety sensor caused by light contact with
foreign objects.

O
.H. The loop guard can only be used together with the mounting system BTU800M.

Mounting bracket for floor mounting BTF815M (only with mounting system BTU800M)
Mounting system BTU800M

Loop guard

Safety sensor

1
2
3
4

Figure 7.18: Loop guard

% Attach the safety sensor to the mounting system.
% Engage the loop guard for the optics cover from above into the mounting system.
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8 Electrical connection

A WARNING

Faulty electrical connection or improper function selection may result in serious injury!
% Only allow competent persons to perform the electrical connection.

% For access guarding, activate the start/restart interlock and make certain that it cannot be unlocked
from within the danger zone.

% Select the functions so that the safety sensor can be used as intended (see chapter 2.1 "Approved
purpose").

% Select the safety-relevant functions for the safety sensor (see chapter 5.2 "Function modes of safety
sensor").

% Always loop both safety-related switching outputs OSSD1 and OSSD2 into the work circuit of the
machine.

% Signal outputs must not be used for switching safety-relevant signals.

NOTICE
Laying cables!

% Lay all connection cables and signal lines within the electrical installation space or permanently in
cable ducts.

% Lay the cables and lines so that they are protected against external damages.
% For further information: see EN ISO 13849-2, Table D.4.

8.1 Electrical supply
see table 15.7.

Functional earth
NOTICE

Always connect the housing of the safety sensor to functional earth or ground!

% The housing of the safety sensor must always be connected to earth (functional earth) or machine/
vehicle ground.

% If the safety sensor is attached to a non-conductive material (e.g. a concrete wall), the housing of the
safety sensor must be earthed.

» Factory recommendation: Functional earth via a ground strap/braid (low impedance for RF).
Connection points for self-tapping screws used for the ground connection are provided and labeled
on the bottom of the connection unit (see figure 8.3).

 Functional grounding via the shield of the connection cable.

For grounding, the shield of the connection cable in the switch cabinet must be connected to earth or
machine/vehicle ground.

NOTICE
Make sure that potential equalization is provided!

% If the housing of the safety sensor or the mounting bracket — despite being mounted on a non-conduc-
tive material — is connected to metallic parts (even temporarily), you must ensure that the appropriate
potential equalization is provided between the switch cabinet and housing potential; e.g. by grounding
the Ethernet connection.

8.2 Interfaces

The safety sensor has two interfaces:
* Interface for connection with the control system
* Interface for communication with PC or laptop

Leuze electronic RSL 410 58



& Leuze electronic

Electrical connection

Table 8.1: Interfaces
Interface Type Function
Control M12 connec- * Power supply . _
tor, 8-pin + Switching lines and signal lines

Communica- M12 - RJ 45 | Configuration interface and data interface:

tion » Parameter configuration
* Protective field definition and warning field definition
« Data transmission and measurement value transmission
* Diagnosis

The control cable is permanently attached to the connection unit. A protection cap on the connection unit
protects the communication interface when no PC is connected.

8.21

Pin assignment for control M12

The safety sensor is equipped with a connection cable with a 8-pin M12 connector.

FE@

Figure 8.1: Pin assignment of safety sensor
Table 8.2: Pin assignment

Pin Core color Signal Description

1 White RES1 Start/restart input, protective function A
Acknowledgement

2 Brown UB Supply voltage

3 Green EA1 Contactor monitoring OSSD A
State signaling, configurable

4 Yellow A1 State signaling

5 Gray OSSDA1 Safety-related switching output, protective
function A

6 Pink OSSDA2 Safety-related switching output, protective
function A

7 Blue GND / Ground Supply voltage ground

8 Red MELD Output signal
State signaling, configurable

M12 thread FE Functional earth, connection cable shield.
The shield of the connection cable is on the
thread of the M12 plug. The thread is part of
the metallic housing.

8.2.2 Pin assighment of M12 Ethernet interface (communication) ( D-coded)

The safety sensor is equipped with a 4-pin M12 connector.
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Figure 8.2:  Pin assignment of the Ethernet interface

Table 8.3: Pin assignment of the Ethernet interface

PIN Signal Description

1 TD+ Data communication, transmission

3 TD- Data communication, transmission

4 RD- Data communication, reception

2 RD+ Data communication, reception

FE GND/shield Functional earth, communication cable shield. The shield of the intercon-
nection cable is on the thread of the M12 plug. The thread is part of the
metallic housing. The housing is at the same potential as functional
earth.

8.3 Connection unit CU408-M12

]

S

i
N

M5 2x S
— —
1 M12 socket, A-coded, connection to the control
2 M12 socket, D-coded, Ethernet communication connection
M5  Connection for functional earth with M5 x 10 self-cutting/self-tapping (gas tightness) and ground
strap

Figure 8.3: Connection unit CU408-M12
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8.4  Circuit diagram example
a1 E—\|—\
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Leuze electronic Leuze electronic
ROTOSCAN RSL 400 MSI-SR4B
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* Spark extinction circuit, suitable spark extinction provided
Figure 8.4: RSL 410 with MSI-SR4B safety relay
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9 Configuring the safety sensor

To start up the safety sensor in your application, the safety sensor must be individually adapted using the
software. All configuration data is defined using the configuration and diagnostics software.

General procedure for configuring safety sensor

% Assessing the risk
» The system has been determined and its boundaries defined.
» The safety sensor has been selected as the safety component.

* The type of guarding has been determined (danger zone guarding, point of operation guarding,
access guarding).

% Calculating safety distance
Shape and size of the protective and warning fields
% Configuring the safety sensor

» Configuration and diagnostics software (see chapter 4 "Configuration and diagnostic software
Sensor Studio")

» Determine the configuration project (see chapter 9.3 "Determining configuration project")
+ Configure the protective function (see chapter 9.4 "Configuring protective function")
% Checking function (see chapter 11 "Testing")

9.1 Defining safety configuration

A WARNING

Serious accidents caused by incorrect safety configuration!

The protective function of the safety sensor is only ensured if the safety sensor is correctly configured for
the intended application.

% Allow only competent persons to perform safety configuration.

% Select the safety configuration so that the safety sensor can be used as intended (see chapter 2.1
"Approved purpose").

% Select the protective field dimensions and contours according to the safety distance calculated for the
application (see chapter 7.1.1 "Calculation of safety distance S").

% Select the parameters of the safety configuration according to your risk analysis.

& After start-up, check the function of the safety sensor (see chapter 11.1 "Before the initial start-up and
following modifications").

A WARNING

Additional protection against manipulation when the monitoring time is increased!

If the monitoring time is increased to above 5 s or if manipulation protection is deactivated, the system
operator must introduce other measures to prevent manipulation.

% For example, make sure that the distance range in which manipulation is possible cannot be accessed
by personnel under normal operating conditions.
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NOTICE

OSSDs will switch off if no reflection signals are being measured!

If the safety sensor is unable to measure any reflection signals in a continuous scanning angle of > 45°
for a long period of time, the safety-related switching outputs switch off. In certain application types (e.g.
in buildings with extremely large distances), the safety sensor may not be able to measure any reflection
signals. For such application types, it is possible to set or deactivate the monitoring times.

% In the CONFIGURATION menu, click the Other option.
The OTHER dialog box opens.

% In the PROTECTION AGAINST MANIPULATION dialog box, define the monitoring time according to
your specific conditions.

If the parking position is active, there will be no manipulation monitoring.

Prerequisites:
* The safety sensor is mounted (see chapter 7 "Mounting") and connected (see chapter 8 "Electrical
connection") correctly.

» Dangerous process is switched off, outputs of the safety sensor are disconnected, and the system is
protected against being switched back on.

» The size of the protective field is determined on the basis of the mounting location, the calculated
safety distances and additional distances.

» The start/restart operating mode required by the application has been determined.
» The conditions for field pair changeover, if required, have been determined.

+ The configuration and diagnostics software for the safety sensor is installed on the PC (see
chapter 4.2 "Installing software").

O Many safety-relevant parameters are preset for each application in the configuration and diag-
nostics software. Use these preset values where possible.

Procedure
All configuration data is defined using the configuration and diagnostics software.
To configure the safety sensor, proceed as follows:

% Connect the PC to the safety sensor
% Start the software
» Set up communication
» Determine the configuration project
% Configure the protective function using the project wizard

Protective/warning field configuration
» Resolution and response time
« Start-up behavior
» Contactor monitoring
+ Field pair changeover
% Save configuration project
% Transferring a configuration to the safety sensor

% Create a record document for the device configuration and protective field dimensioning. The document
must be signed by the person responsible for the configuration.

To document the configuration, you can create a PDF file of the safety configuration or save the config-
uration and settings in an *.xml file.

O  The configuration data is stored in the connection unit of the safety sensor and is therefore also
IL available after replacement or repair of the scanner unit. The configuration data only needs to be
transferred again if changes are made to the configuration.
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9.2 Connecting safety sensor to PC

9.2.1 Connection via Ethernet cable
Connect the Ethernet cable to the PC or to the network; see the document “Quick Start Guide RSL 400”.

O
]:L The TCP/IP protocol is used for communication via Ethernet.

o Inaddition to configuration, you can also use the Ethernet interface to forward measurement data
IL in real-time (process data) to another computer, e.g. for vehicle navigation. This process data
cannot be used for safety-relevant purposes.

9.2.2 Connection via Bluetooth

O
.H. No process data is transferred in the case of connection via Bluetooth.

Prerequisites: Bluetooth communication of the safety sensor has been activated (see chapter 9.2.3
"Communication between safety sensor and PC")

% Activate the Bluetooth interface on the PC.
% Select the safety sensor as the device for the Bluetooth connection.

9.2.3 Communication between safety sensor and PC

The following communication settings are active when the safety sensor is delivered:

LAN
+ DHCP: Obtain IP address automatically

Bluetooth
* Bluetooth module activated
* Device scan activated

You can change the communication settings on the PC using the configuration and diagnostics software
in order to, for example, assign a permanent IP address to the safety sensor in your network.

% Start the configuration and diagnostics software on your PC.

* The mode selection of the Project Wizard is displayed.
+ If the mode selection is not shown, click the [Project Wizard] button ( & ) in the menu bar of the

software to start the project wizard.
% Select the configuration mode and click [Next].
The Project Wizard displays the device selection list containing the configurable safety sensors.
% Select the safety sensor from the device selection list and click [Next].

The initial screen for the configuration project is displayed together with information for identification of the
selected safety sensor.

% In the initial screen, click the SETTINGS tab.
The SETTINGS menu opens.

Assign permanent IP address

% Select the menu command Communication > LAN.

% In the DHCP dialog box, deactivate the Obtain /P address automatically checkbox.
% In the CONNECTION SETTINGS dialog box, enter the IP address information.
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Activating/deactivating the Bluetooth interface
% Select the menu command Communication > Bluetooth.

% Activate/deactivate communication with the safety sensor via the Bluetooth interface using the Activate
Bluetooth module checkbox. If the Bluetooth module is deactivated, communication with the safety sen-
sor via the Bluetooth interface is not possible.

% Activate/deactivate the Bluetooth device scan using the Activate device scan checkbox. If the device
scan is deactivated, the safety sensor will not be found during the Bluetooth device scan. To allow com-
munication via the Bluetooth interface, you must enter the device identification of the safety sensor man-
ually.

9.3 Determining configuration project
% Start the configuration and diagnostics software on your PC.
» The mode selection of the Project Wizard is displayed.
« If the mode selection is not shown, click the [Project Wizard] button ( & ) in the menu bar of the soft-

ware to start the project wizard.

o  During installation of the software, a user admin (without password query) is created so that you

J:L can start the software without user identification. If other users are registered (Tools > User man-
agement in the FDT frame menu), you must log in at the software with a user name and pass-
word.

This setting allows you to connect to the safety sensor and to read out, upload, enter or change

the safety configuration and all settings using the RSL 400 device DTM. The password for the

safety sensor only needs to be entered (i.e. the access level only needs to be changed) when

the changes are downloaded to the safety sensor (see chapter 4.5.1 "Selecting access level").
% Select the configuration mode and click [Next].

The Project Wizard shows the list of configurable safety sensors.

O You can use a prepared configuration project as a template and make changes to it. To do so,
IL select the configuration mode Open a stored project file.

If you want to load the configuration project currently stored in the safety sensor to the PC, select
the configuration mode Device selection with device scan and establishment of connection
(online).

% Select the safety sensor in the Sensor list and click [OK].

Alternatively, you can select the safety sensor by entering the part number or by specifying the sensor
range and the sensor type.

The device manager (DTM) of the safety sensor shows the initial screen for the configuration project.
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Figure 9.1:  Safety configuration using Configuration Wizard

o  The device manager (DTM) starts without querying the access level of the user. During commu-
IL nication with the safety sensor, the safety sensor does however query the access level of the
user. To change the access levels, see chapter 9.7 "Selecting access level".

9.4  Configuring protective function
Prerequisites: The safety distance, additional distances and protective field dimensions and contours have
been determined according to the mounting position (see chapter 7.1.1 "Calculation of safety distance S").
% In the initial screen, click the CONFIGURATION tab.

The CONFIGURATION menu opens with the options:
» Administration
* OSSDs

If the OSSDs option is selected in the CONFIGURATION menu, the Profective function A option is
displayed.

» QOutputs
» Other

9.4.1 Creating simple safety configuration

To create a safety configuration for simple commissioning, you must first perform five configuration steps
to access the editor used for defining the contours of the protective and warning fields.

[I1By clicking Next, you can proceed to the next configuration step without selecting the corresponding
option in the CONFIGURATION menu.

If you make changes to the default settings in a configuration step, first click the [Confirm] button and then
[Next].

Y Administration
% OSSDs
% Profective function A
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9.4.2

9.4.3

9.4.4

Y Bank A1
Y Outouts

Entering administration parameters

% In the CONFIGURATION menu, click the Administration option.

The ADMINISTRATION dialog box opens.

% In the input fields, enter the device data and the project data for the configuration project.

Activating protective function and contactor monitoring

% In the CONFIGURATION menu, click the OSSDs option.

The OSSDs dialog box opens.

% In the FUNCTION MODE list, select the protective function of the safety sensor.
The Protective function A option is shown in the CONFIGURATION menu.

O The changeover-capable protective/warning field pairs for the selected protective function are
defined in configuration banks.

% In the CONTACTOR MONITORING list, activate the contactor monitoring of the safety sensor:
+ EDM OSSD A

O The activated contactor monitoring (EDM) is assigned to indication signal outputs 101 and/or
102. These signal outputs are thus disabled for the configuration of the signal outputs.

& Click the [Confirm] button.

Creating and configuring protective/warning field pairs
The changeover-capable protective/warning field pairs for the selected protective function are defined in
configuration banks. The configuration banks are shown in the navigation tree of the configuration menu
as “Bank”, e.g. Bank AT.
Creating banks
% In the CONFIGURATION menu, click the Profective function A option.
The PROTECTIVE FUNCTION A dialog box opens.
% Enter the description of the protective function in the input field.
% In the CONFIGURATION menu, right-click the Protective function A option.
Select Add configuration bank.
The Add bank dialog box opens.

% In the Bank list, select the number of the bank and click the [Add] button. When you have added all
banks for the protective function, click [Close].

The Bank 1 option is shown under Profective function A in the CONFIGURATION menu.

Configuring banks

The resolution for hand, leg or body detection, the response time and start-up behavior of the safety sensor
and the field pair changeover for the protective/warning field pairs are configured via the banks.

O  Forresolution, response time and DTS speed, select the values that you used for calculating the
safety distances and additional distances for the application assigned to the configuration bank.

% In the CONFIGURATION menu, select the bank the configuration of which you want to define.
The RESOLUTION, RESPONSE TIME and START-UP BEHAVIOR dialog boxes are displayed.

% In the RESOLUTION dialog box, enter the resolution and, if applicable, the maximum speed of a driv-
erless transportation system (DTS) in the input fields.
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o Ifinthe Resolutionand Max. DTS speedinput fields you select values >0, the application usually
IL used for the bank is displayed in the Application field, e.g. Point of operation guarding.

For access guarding, point of operation guarding and danger zone guarding, you must select
Max. DTS speed = 0!
% In the RESPONSE TIME dialog box, select the response time of the safety sensor.

% In the START-UP BEHAVIOR dialog box, select the start-up behavior and the restart time of the safety
sensor.

O  Configuration of the start-up behavior is only implemented if the corresponding electrical signal
connections exist; see chapter 8 "Electrical connection".

% Click the [Confirm] button.

% Configure all other banks of the protective function following the described procedure.

Create protective and warning fields

A field pair consists of one protective field and one warning field.

% In the CONFIGURATION menu, right-click the Bank 7 option under Protective function_A
Select Add field pair.

The Add field pair dialog box opens.

% In the Field pair list, select the number of the field pair and click the [Add] button. When you have added
all field pairs for the bank, click [Close].

The added field pairs are shown in the CONFIGURATION menu as an option under Bank 7under Protec-
tive function_A. The Parameters option is displayed for each field pair.

Configure protective and warning fields
Defining contours and boundaries for protective field and warning field

il Sencs Snao - New Frogecy «unsaved - [RSL 400 - Man ot

o [T

Curvor postson s b e
Mo e et

posson 167 e

¥ poston 1342 e

Angle =T

FIELD PAIR

A flokd pair consists of one profoctive

it ] s warmiing Mkl

® if the protective Sl ks violated, the
e

EEEEEEyES8ERREEEES |

moniioeng and rekase of the feld par
changesver, can ba configured is
i pst_parnimaors

Examph showieg dosignation of a fiekd
pair
* AlZ Protective function A,
configuration bank 1, flekd pair 2
The prolective and waming fleks can be
- st up and dafined Using variows
+  methads (see Dpliing protoctive Aod

EEEEEE

Powecisd T [

\ 1 Toolbar of field editor

2 Display of field coordinates
3 Structure of safety configuration

Figure 9.2: Field editor with toolbar for field definition

% In the CONFIGURATION menu, click the field pair the protective and warning fields of which you want
to define.

% Click the button and define the contours and boundaries of the protective field.
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9.5

9.6

NOTICE

Determine protective field size!

The protective field size is determined by the calculated safety distances and additional distances that
you determined for the application assigned to the configuration bank.

% Click the E button and define the contours and boundaries of the warning field.
The field pair is fully configured.

o By right-clicking the field pair in the CONFIGURATION menu, you can calculate an autocontour
IL for the protective or warning field.

You can determine the display options for the field editor in the menu SETTINGS > Field editor
display options (see chapter 4.5.6 "SETTINGS").

% Configure all other field pairs of the configuration bank following the described procedure.

Saving configuration

To save the changed configuration loaded in the software, you can transfer the configuration and settings
to the safety sensor or save them in a file on the PC.

Saving safety configuration as PDF file

% In the CONFIGURATION menu, click the [Create PDF file of safety configuration] button.

% Determine the storage location and the file name for the safety configuration.

% Click [Save].

The safety configuration is saved as a PDF file.

Saving configuration and settings as file

% In the CONFIGURATION menu or in the SETTINGS menu, click the [Save configuration and settings
to file] button.

% Determine the storage location and the name of the configuration file.
% Click [Save].
The configuration and settings are saved in the file format *.xml.

Saving configuration project as file
% In the menu bar of the FDT frame menu, click the k- button.
Alternatively, select the menu command File > Save.
% Determine the storage location and the name of the configuration project file.
% Click [Save].

Transferring configuration project to safety sensor

The changes that you have made to the configuration only become effective when the changed configu-
ration project file is transferred to the safety sensor.

Prerequisites:
» The software and safety sensor are connected.
» The changed configuration project has been loaded in the software.
» The individual password for the access level Engineeris available.
» Only users with the access level Engineer can transfer configuration data to the safety sensor. To
change the access level, see chapter 9.7 "Selecting access level".

+ If no individual password has been defined for the access level Engineer, use the preset default
password (safety).

O Alternatively, you can transfer a configuration project saved as a file on the PC directly to the
safety sensor.

Leuze electronic RSL 410 69



& Leuze electronic Configuring the safety sensor

% In the menu bar of the FDT frame menu, click the [download arrow] button.
Alternatively: In the FDT menu bar, select Device > Download parameters.
The software asks for the access level and the password.

% Select the access level Engineerand enter the preset default password (safety) or the defined individual
password.

Confirm with [OK].

% Before downloading the safety configuration, check whether you are connected to the correct safety
sensor.

Confirm the displayed safety notice with [Yes].
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Figure 9.3: Check before safety configuration is downloaded

The software transfers the data of the configuration project to the safety sensor.

After successful transfer, the safety sensor immediately enters safety mode, i.e. the safety-related
switching outputs switch on if all conditions are fulfilled.

» The configuration data is saved in the connection unit of the safety sensor.

+ A copy of the safety configuration is saved in the scanner unit of the safety sensor.
If, due to a device swap-out, the scanner unit is attached to a brand new, unconfigured connection
unit, the safety configuration is transferred from the scanner unit to the connection unit.

NOTICE

Observe the safety notices regarding changes to the configuration!

Transferring the safety configuration from the scanner unit to the connection unit corresponds to recon-
figuration of the system consisting of scanner unit and connection unit.

% Observe the relevant safety notices regarding changes to the configuration (see chapter 9.1 "Defining
safety configuration").

% Check the displayed signature.
% Confirm successful transfer of the safety configuration to the safety sensor with [OK].

The safety configuration has only been successfully transferred to the safety sensor when the confirma-
tion dialog is displayed during the download.
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Figure 9.4: Confirmation: safety configuration downloaded

O
]:L The safety-related switching outputs will already have switched on if all conditions are fulfilled.

The software has saved the configuration project in the safety sensor.

Selecting access level

Using the device manager (DTM) you can change the access level of the user, if necessary see
chapter 5.1 "Authorization concept of safety sensor".

% Click in the DTM menu bar on the [Change access level] button ().
The Change access level dialog box opens.

% In the Authorization list, select the item Engineer, Expertor Observerand enter the default password or
the password defined for the individual user (see chapter 4.5.6 "SETTINGS").

 Default password for Engineer. safety

» Default password for Expert. comdiag
% Confirm with [OK].

Reset safety configuration

The device manager (DTM) can be used to reset the safety configuration to the default configuration (one
protective function, no restart).

% In the DTM menu bar, click the [Reset safety configuration] button.

Users with the access level Engineer can additionally transfer the changed safety configuration to the
safety sensor (see chapter 9.6 "Transferring configuration project to safety sensor").
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10

10.1

10.2

10.3

10.4

Starting up the device

A WARNING

Improper use of the safety sensor may result in serious injury!

% Make certain that the entire device and the integration of the optoelectronic protective device was
inspected by competent and instructed persons.

% Make certain that a dangerous process can only be started while the safety sensor is switched on

Prerequisites:

» Safety sensor mounted (see chapter 7 "Mounting") and connected (see chapter 8 "Electrical connec-
tion") correctly

» Operating personnel were instructed in proper use

» Dangerous process is switched off, outputs of the safety sensor are disconnected, and the system is
protected against being switched back on

% After start-up, check the function of the safety sensor (see chapter 11.1 "Before the initial start-up and
following modifications").

Switching on

Requirements for the supply voltage (power supply unit):
* Reliable mains separation is ensured.
 Current reserve of at least 3 A is available.

% Switch on the safety sensor.

Aligning the safety sensor

NOTICE
Faulty or incorrect alignment may result in an operating fault!

% The alignment performed during start-up should only be performed by qualified personnel.

% Observe the data sheets and mounting instructions of the individual components.

To simplify alignment during start-up, the safety sensors of the RSL 400 series have an integrated elec-
tronic spirit level.

% Align the safety sensor using the integrated electronic spirit level.

Unlocking start/restart interlock

A WARNING

Premature unlocking of the start/restart interlock may result in serious injury!
If the start/restart interlock is unlocked, the system can start up automatically.

% Before unlocking the start/restart interlock, make certain that no people are in the danger zone.

The responsible person can restore the ON state of the safety sensor following process interruptions (due
to triggering of protective function, failure of the voltage supply).

% Unlock the start/restart interlock using the reset button.

The safety-related switching outputs are only enabled if you hold down the reset button for between
0.12sand 4 s.

Shutting down

Temporarily shutting down the machine with the safety sensor

When you shut down the machine with the safety sensor temporarily, you do not have to observe any more
steps. The safety sensor saves the configuration and starts again with the switch-on with this configuration.
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10.5

10.6

Shutting down safety sensor and removing from machine

When you shut down the safety sensor and store it away for a later use, you must reset the safety sensor
to the factory settings.

% Reset the safety sensor to the factory settings using the software.

In the device manager (DTM) of the safety sensor, select the CONFIGURATION tab. Click the [Reset
safety configuration] button.

Restarting

Restarting the machine with the safety sensor

If you have only shut down the system with the safety sensor temporarily and are restarting the system
without any changes, you can restart the safety sensor with the configuration that applied with the shut-
down. The configuration remains saved in the safety sensor.

% Perform a function test (see chapter 11.3 "Periodically by the operator").

Starting up machine with safety sensor after modification or reconfiguration

If you have performed significant changes on the machine or have reconfigured the safety sensor, the
safety sensor must be checked as with the initial start-up.

% Test the safety sensor (see chapter 11.1 "Before the initial start-up and following modifications").

Starting up replacement scanner unit

The replacement scanner unit and the original scanner unit must be the same with regard to the following
points:

» Scanner unit type in accordance with name plate or downward compatible with previous scanner unit
with greater range and greater function range

» Mounting on the existing connection unit
Mounting and aligning replacement scanner unit

% Mount the replacement scanner unit on the connection unit instead of the original scanner unit (see
chapter 13.1 "Changing scanner unit").

NOTICE

Realignment of safety sensor not hecessary!

Realignment of the safety sensor is not necessary since the replacement scanner unit is mounted on the
existing, aligned connection unit.

Transferring configuration to replacement scanner unit

The configuration stored in the connection unit is automatically transferred to the replacement scanner
unit.

A WARNING

Malfunctioning of safety sensor due to incorrect configuration!

% The safety sensor configuration stored in the connection unit can only be adopted without changes if
the replacement scanner unit and the original scanner unit are downward compatible with respect to
range and performance class.

The replacement scanner unit will reject an invalid configuration.

% Change the configuration parameters of the safety sensor using the configuration and diagnostic soft-
ware according to the performance class of the replacement scanner unit.

% Change the configuration parameters of the safety sensor using the configuration and diagnostic soft-
ware according to the operating range of the replacement scanner unit.

Transferring configuration with the PC

If the range and/or performance class of the replacement scanner unit is not compatible with the original
scanner unit, you must adapt the configuration of the safety sensor to the replacement scanner unit.

% Connect the safety sensor's Ethernet communication interface with the PC.
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% Configure the safety sensor according to the range and performance class of the replacement scanner
unit (see chapter 9 "Configuring the safety sensor").

% Transfer the configuration to the safety sensor with the replacement scanner unit.

The alphanumerical display confirms successful transfer of the configuration.
The replacement scanner unit is not compatible with the connection unit if the safety sensor displays a
fault.

Checking replacement scanner unit

The check performed on the replacement device depends on whether you automatically adopted the

configuration from the connection unit or whether you transferred the changed configuration to the safety

sensor.

% If you adopted the configuration from the connection unit, check the safety sensor using the checklist
for the daily test.

% If you transferred a new configuration to the safety sensor, check the safety sensor according to the rou-

tine for initial start-up (see chapter 11.1.1 "Checklist for integrator — to be performed prior to the initial
start-up and following modifications").
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11

11.1

11.1.1

Testing

NOTICE

% Safety sensors must be replaced at the end of their mission time (see chapter 15 "Technical data").
% Always exchange entire safety sensors.

% For the tests, observe, if necessary, nationally applicable regulations.

% Document all tests in a comprehensible manner and include the configuration of the safety sensor

along with the data for the safety- and minimum distances in the documentation.

Before the initial start-up and following modifications

A WARNING

Unpredictable machine behavior during initial start-up may result in serious injury!

% Make certain that there are no people in the danger zone.

% Before they begin work, train the operators on their respective tasks. The training is the responsibility of
the operating company.

% Attach notices regarding daily testing in the respective national language of the operator on the machine
in a highly visible location, e.g. by printing out the corresponding chapter (see chapter 11.3 "Periodically
by the operator").

% Test the electrical function and installation according to this document.
Acc. to IEC TS 62046 and national regulations (e.g. EU directive 2009/104/EC), tests are to be performed
by competent persons in the following situations:

* Prior to the initial start-up

+ Following modifications to the machine

+ After longer machine downtime

* Following retrofitting or new configuration of the machine

% As preparation, check the most important criteria for the safety sensor according to the following check-
list (see chapter 11.1.1 "Checklist for integrator — to be performed prior to the initial start-up and follow-
ing modifications"). Completing the checklist does not replace testing by a competent person!

Not until proper function of the safety sensor is ascertained may it be integrated in the control circuit of the
system.

Checklist for integrator — to be performed prior to the initial start-up and following modifications

NOTICE
Completing the checklist does not replace testing by a competent person!

% If you answer one of the items on the check list with 1o, the machine must no longer be operated (see
table 11.1).

% |EC/TS 62046 contains additional recommendations on testing protective devices.

Table 11.1: Checklist for integrator — to be performed prior to the initial start-up and following
modifications

Check: Yes | No n. a.®

Is the safety sensor operated acc. to the specific environmental conditions that
are to be maintained (see chapter 15 "Technical data")?

Is the safety sensor correctly aligned and are all fastening screws and connec-
tors secure?

Are safety sensor, connection cables, connectors, protection caps and command
devices undamaged and without any sign of manipulation?
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Check: Yes | No n. a.d

Does the safety sensor satisfy the required safety level (PL, SIL, category)?

Are the safety-related switching outputs (OSSDs) integrated in the downstream
machine control acc. to the required safety category?

Are switching elements that are controlled by the safety sensor monitored
according to the required safety level (PL, SIL, category) (e.g., contactors
through EDM)?

Are all points of operation near the safety sensor accessible only through the
protective field of the safety sensor?

Are the necessary additional protective devices in the immediate surroundings
(e.g., safety guard) properly mounted and secured against tampering?

If it is possible to be present undetected between the safety sensor and point of
operation: is an assigned start/restart interlock functional?

Is the command device for unlocking the start/restart interlock mounted in such a
way that it cannot be reached from within the danger zone and so that the com-
plete danger zone can be seen from the installation location?

Has the maximum stopping time of the machine been measured and docu-
mented?

Is the required safety distance maintained?

Does interruption with a test object intended for this purpose cause the danger-
ous movement(s) to stop?

Is the safety sensor effective during the entire dangerous movement(s)?

Is the safety sensor effective in all relevant operating modes of the machine?

Is start-up of dangerous movements reliably prevented if the protective field is
interrupted with a test object intended for this purpose?

Was the sensor detection capacity successfully tested (see table 11.2)?

Were distances to reflective surfaces taken into account during configuration and
no reflection bypasses subsequently detected?

Are notices for regular testing of the safety sensor legible to the operator and are
they located in a highly visible location?

Are changes to the safety function (e.g. protective field changeover) not easy to
achieve through tampering?

Are settings that could result in an unsafe state possible only by means of key,
password or tool?

Are there incentives that pose stimulus for tampering?

Were the operators instructed prior to starting work?

a) not applicable
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11.2 To be performed periodically by competent persons

The reliable interaction of safety sensor and machine must be periodically tested by competent persons in
order to detect changes to the machine or impermissible tampering with the safety sensor.

Acc. to IEC/TS 62046 and national regulations (e.g., EU directive 2009/104/EC), tests of elements which
are subject to wear must be performed by competent persons at regular intervals. Testing intervals may
be regulated by nationally applicable regulations (recommendation acc. to IEC/TS 62046: 6 months).

% Have all tests performed by competent persons.
% Observe the nationally applicable regulations and the time periods specified therein.

% As preparation, observe the checklist (see chapter 11.1 "Before the initial start-up and following modifi-
cations").

11.3 Periodically by the operator

The function of the safety sensor must be checked periodically depending on the given risk (e.g. daily or

on change of shifts) according to the following checklist so that damages or prohibited tampering can be
detected.

Due to complex machines and processes, it may be necessary under certain circumstances to check some
points at longer time intervals. Observe the classification in “Test at least” and “Test when possible”.

A WARNING

Unpredictable machine behavior during the test may result in serious injury!
% Make certain that there are no people in the danger zone.

% Before they begin work, train the operators on their respective tasks and provide suitable test objects
and an appropriate test instruction.

11.3.1 Checklist — periodically by the operator

NOTICE
% If you answer one of the items on the check list with 170, the machine must no longer be operated (see
table 11.1).
Leuze electronic RSL 410
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Table 11.2: Checklist — regular function test by trained operators/persons

Test at least: Yes No

Are safety sensor and connectors securely mounted and free of obvious signs of dam-
age, changes or tampering?

Were obvious changes made to access or entry possibilities?

Test the effectiveness of the safety sensor:
» The LED 1 on the safety sensor must illuminate green (see chapter 3.3.1 "LED indi-
cators").
* Interrupt the protective field using a suitable opaque test object (see figure 11.1).

O—»O

Figure 11.1: Checking the protective field function with test rod

Does the LED 1 on the safety sensor illuminate constantly red while the protective field is
interrupted?

When possible, test during running operation: Yes | No

Protective device with approach function: during machine operation, the protective field
is interrupted with the test object — are the obviously dangerous machine parts stopped
without noticeable delay?

Protective device with presence detection: the protective field is interrupted with the test
object — does this prevent operation of the obviously dangerous machine parts?
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12

12.1

12.2

Diagnostics and troubleshooting

What to do in case of failure?

After switching the safety sensor on, the display elements assist in checking the correct functionality and
in faultfinding (see chapter 3.3 "Display elements").

In case of failure, you can determine the fault from the LED displays and read a message from the display.
With the error message you can determine the cause of the error and initiate measures to rectify it.

NOTICE
If the safety sensor responds with an error display, you will often be able to eliminate the cause yourself!

% Switch off the machine and leave it switched off.
% Analyze the cause of the fault using the diagnostics displays and rectify the fault.

% If you are unable to rectify the fault, contact the Leuze electronic branch responsible for you or call the
Leuze electronic customer service (see chapter 14 "Service and support").

Diagnostics displays

The diagnostics displays consist of one letter plus four numbers, divided into classes consisting of letters
and the first number.

Diagnostics classes:
* | (Information)

* No OSSD switch-off

* Unhindered operation possible
U (Usage)

Application error

E (External)

External fault

F (Failure)

Internal device error

+ OSSD switch-off
» Self test unsuccessful
» Hardware error

P (Parameter)
Inconsistency in configuration

Table 12.1: Diagnostics displays in order of ascending ID number
Diagnos- | Diagnostics message Measure
tic ID
u0370 Input level at the electrical inputs is unclear. | Check the wiring of the safety sensor.
P0409 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown bank switchover. configuration. The type of safety sensor

must be the same as the type stored in the
connection unit or in the Sensor Studio soft-

ware.
P0410 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown output signals. configuration. The type of safety sensor

must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.
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Diagnos- | Diagnhostics message Measure

ticID

P0413 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown inputs SE1 and SE2. configuration. The type of safety sensor

must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.

P0414 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown EDM inputs. configuration. The type of safety sensor

must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.

P0415 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown field pair monitoring mode. configuration. The type of safety sensor

must be the same as the type stored in the
connection unit or in the Sensor Studjo soft-
ware.

P0416 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown field pair monitoring parameters. configuration. The type of safety sensor

must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.

P0417 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown field pair monitoring mode. configuration. The type of safety sensor

must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.

P0419 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown monitoring parameter for the configuration. The type of safety sensor
changeover order. must be the same as the type stored in the

connection unit or in the Sensor Studio soft-
ware.

P0420 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown monitoring mode of the field pair configuration. The type of safety sensor
changeover. must be the same as the type stored in the

connection unit or in the Sensor Studio soft-
ware.

P0421 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown parameter for field pair changeover | configuration. The type of safety sensor
monitoring. must be the same as the type stored in the

connection unit or in the Sensor Studjo soft-
ware.

P0422 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown field pair selection mode. configuration. The type of safety sensor

must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.

P0423 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown field pair selection parameter. configuration. The type of safety sensor

must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.
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Diagnos- | Diagnhostics message Measure
ticID
P0424 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown parameter for manipulation moni- | configuration. The type of safety sensor
toring. must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.
P0425 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown configuration of the output signals. | configuration. The type of safety sensor
must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.
P0426 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown resolution. configuration. The type of safety sensor
must be the same as the type stored in the
connection unit or in the Sensor Studjo soft-
ware.
P0427 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown parameter. configuration. The type of safety sensor
must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.
P0428 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown reflector mode. configuration. The type of safety sensor
must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.
P0429 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown start/restart mode. configuration. The type of safety sensor
must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.
P0430 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown start mode. configuration. The type of safety sensor
must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.
P0431 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown restart mode. configuration. The type of safety sensor
must be the same as the type stored in the
connection unit or in the Sensor Studjo soft-
ware.
P0432 Safety configuration is not compatible: Swap out the safety sensor or change the
unknown OSSD stop mode. configuration. The type of safety sensor
must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.
uo573 EDM fault at system start. Check the wiring of the downstream relays
and that they are functioning correctly.
uo574 Switching fault, EDM at OSSD A: external Check the wiring of the downstream relays
relay does not switch off. and that they are functioning correctly.
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Diagnos- | Diagnhostics message Measure

ticID

uo575 Switching fault, EDM at OSSD A: external Check the wiring of the downstream relays
relay does not switch on. and that they are functioning correctly.

u0576 Switching fault, EDM at OSSD B: external Check the wiring of the downstream relays
relay does not switch off. and that they are functioning correctly.

uos77 Switching fault, EDM at OSSD B: external Check the wiring of the downstream relays
relay does not switch on. and that they are functioning correctly.
u0580 Switching fault at inputs SE1 and SE2; exter-| Check the wiring of the external safety
nal safety device does not switch in accor- | device and that the parameter settings in the
dance with the specifications. configuration are correct.

u0582 Field pair changeover is not performed in Check the changeover times of function
accordance with the specifications config- inputs F1 to F10 or the parameter settings in
ured in the safety sensor: overlap time too | the configuration.
long.

u0583 Field pair changeover is not performed in Check the wiring and the changeover times
accordance with the specifications config- of function inputs F1 to F10.
ured in the safety sensor: no signal for field
pair activation.

u0584 Field pair changeover is not performed in Check the changeover times of function
accordance with the specifications config- inputs F1 to F10 or the parameter settings in
ured in the safety sensor: changeover time | the configuration.
exceeded.

uo0585 Field pair changeover is not performed in Check the wiring of function inputs F1 to F10
accordance with the specifications config- and that the parameter settings in the config-
ured in the safety sensor: changeover order | uration are correct.
not observed.

E0588 Optics cover is soiled. Clean the optics cover. Restart the safety

sensor.

10604 Optics cover is soiled. Clean the optics cover as soon as possible.

Sensor is still in safety mode.

P0653 Safety configuration is not compatible: pro- | Swap out the safety sensor or change the

tective/warning field radius too large. configuration. The type of safety sensor
must be the same as the type stored in the
connection unit or in the Sensor Studio soft-
ware.

P0654 Field pair changeover is not performed in Check the wiring of function inputs F1 to F10
accordance with the specifications config- and that the parameter settings in the config-
ured in the safety sensor: field pair not uration are correct.
defined.

10660 Field pair changeover is not performed in Check the wiring of function inputs F1 to F10
accordance with the specifications config- and that the parameter settings in the config-
ured in the safety sensor: no field pair acti- | uration are correct.
vated at system start.

u0661 Safety-related switching outputs (OSSDs) Check the wiring of the OSSDs.
cannot be switched: short circuit with 0 V,
+24 V DC or between OSSDs.
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Diagnos- | Diagnhostics message Measure
ticID
10719 Timeout of signals RES1 or RES2 (acknowl- | Check the wiring of inputs RES1 and RES2.
edgment button, start/restart). The time specifications for start/restart must
be observed.
PO747 Safety configuration is not compatible: pro- | Change the dimensions and contour of the
tective/warning field radius too small. protection field in the configuration. The min-
imum range of the protection field must be
observed.
10825 Simulation mode has been activated. The safety-related switching outputs
(OSSDs) have been switched off.
10826 Simulation mode has been deactivated. The sensor is again in safety mode.
CAUTION!
Be aware of potential hazards which can
occur when the machine is started up!
F... The monitoring functions have detected an | Create the service file (see chapter 4.5.5
internal error. "DIAGNOSIS")and contact the
Leuze electronic customer service (see
chapter 14 "Service and support").
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13

13.1

Care, maintenance and disposal

Changing scanner unit

If the safety sensor check or an error message indicates a defective scanner unit, change the scanner unit.
Only a trained and competent person is permitted to change the scanner unit.

The scanner unit is changed as follows:
» Detach the scanner unit from the connection unit.
+ Attach the replacement scanner unit to the connection unit.

NOTICE

Safety sensor malfunction caused by dirt!
% Perform all work in an environment which is as dust-free and dirt-free as possible.
% Do not touch any of the parts inside the device.

A WARNING

Malfunctioning of safety sensor due to incompatibility of connection unit and scanner unit! Malfunctioning
of safety sensor due to incorrect configuration!

% Wherever possible, replace the scanner unit with a scanner unit with the same range and performance
class (e.g. RSL 420-M with RSL 420-M). The safety sensor configuration stored in the connection unit
is only adopted without changes if the new scanner unit supports all configured functions.

% Change the configuration parameters of the safety sensor using the configuration and diagnostic soft-
ware according to the performance class of the scanner unit or of the connection unit.

If a scanner unit is attached to a connection unit with a lower performance class (e.g. a scanner unit
RSL 430 to a connection unit CU416), the integrated cable management of the connection unit means
that only the functions of the lower performance class (of the connection unit) are available.

If a scanner unit is attached to a connection unit with a higher performance class (e.g. an RSL 420
scanner unit to a CU429 connection unit), the performance of the scanner unit restricts the functions
to those of the lower performance class (of the scanner unit).

% Change the configuration parameters of the safety sensor using the configuration and diagnostic soft-
ware according to the operating range of the replaced scanner unit.

If the scanner unit is replaced with a scanner unit with a different range (e.g. RSL 420-L with
RSL 420-M), you must check and, if necessary, adapt the configuration of the safety sensor.

O Detailed information on attaching the scanner unit can be found in the document “Quick Start
Guide RSL 400”.

% Undo the quick-release fasteners on both sides of the scanner unit.

% Pull the scanner unit off the connection unit.

% Place the new scanner unit on the connection unit.

% Connect and lock the new scanner unit using the quick-release fasteners on both sides.

% Check the configuration of the safety sensor (see chapter 9 "Configuring the safety sensor").

o If a preconfigured scanner unit is attached to a brand new, unconfigured connection unit, the
IL safety configuration stored in the scanner unit is transferred to the connection unit and you can
use the safety sensor without reconfiguration after a restart.

% Check the safety sensor according to the routine for initial start-up (see chapter 11.1.1 "Checklist for
integrator — to be performed prior to the initial start-up and following modifications").
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13.2

13.3

13.4

Cleaning the optics cover

Clean the optics cover as required by the application-related load rating.

Use the cleaning set consisting of special cleaning agent and cleaning cloths for cleaning (see chapter 17
"Ordering information and accessories").

The procedure for cleaning depends on the kind of contamination:

Soiling Cleaning

% Vacuum without touching or blow away softly, oil-free

& Wipe free in one swipe with cleaning cloth

% Vacuum without touching or blow away softly, oil-free
or
Wipe free in one swipe with cleaning cloth

& Wet with cloth soaked in cleaning agent

% Wipe free in one swipe with cleaning cloth

% Vacuum without touching

% Wipe free in one swipe with cleaning cloth soaked with cleaning
agent

% Wet with cloth soaked in cleaning agent

% Wipe free in one swipe with cleaning cloth

% Wipe free in one swipe with cleaning cloth

Particles, loose, scouring

Particles, loose, non-scouring

Particles, sticking

Particles, statically charged

Particles/drops, smearing

Water drops

% Wet with cloth soaked in cleaning agent
% Wipe free in one swipe with cleaning cloth
% Wet with cloth soaked in cleaning agent
% Wipe free in one swipe with cleaning cloth
% Change optics cover

Qil drops

Fingerprints

Scratches

NOTICE
The wrong cleaning agents or cloths will damage the optics cover!

% Do not use any scouring cleaning agents or scratching cloths.

o If cleaning takes longer than four seconds, e.g. with fingerprints, the safety sensor displays a
IL fault of optics cover monitoring. After cleaning is complete, the safety sensor resets itself auto-
matically.

% Soak cloth with cleaning agent.
% Wipe optics cover free in one swipe.

Servicing
The device does not normally require any maintenance by the operator.
Repairs to the device must only be performed by the manufacturer.

% For repairs, contact your responsible Leuze electronic subsidiary or Leuze electronic customer service
(see chapter 14 "Service and support").

Disposing
% For disposal observe the applicable national regulations regarding electronic components.
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14  Service and support

24-hour on-call service at:
+49 (0) 7021 573-0

Service hotline:

+49 (0) 8141 5350-111

Monday to Thursday, from 8.00 a.m. to 5.00 p.m. (UTC+1)
Friday, 8.00 a.m. to 4.00 p.m. (UTC+1)

E-mail:
service.protect@leuze.de

Return address for repairs:
Service center

Leuze electronic GmbH + Co. KG
In der Braike 1

D-73277 Owen / Germany
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15 Technical data

15.1 General specifications

Table 15.1: Safety-relevant technical data
Type in accordance with IEC/EN 61496 Type 3
SIL in accordance with IEC 61508 SIL 2
SILCL in accordance with IEC/EN 62061 SILCL 2
Performance Level (PL) in accordance with PLd
EN ISO 13849-1
Category acc. to EN 1ISO 13849-1 Cat. 3
Average probability of a failure to danger per hour | 9x10-® 1/h
(PFH,)
Mission time (T,,) 20 years
Table 15.2: Optics
Laser protection class in accordance with Class 1
EN 60825-1
Wavelength 905 nm (infrared)
Impulse duration 25ns
Maximum output power (peak) 35W
Pulse frequency of laser transmitter 90 kHz

Scanning rate

25 scans/s, equal to 40 ms/scan

Scanning angle Max. 270°
Angular resolution 0.1°
Tolerance field of reference contour +200 mm

Table 15.3: Protective field data
Safety sensor RSL 410 RSL 420 RSL 430 RSL 440
Number of field pairs 1 10 10+ 10 100
Reference contour selectable X X X X
Minimum adjustable range 200 mm

housing edge

Detection range of the test object from the

The detection capability is limited in the 0 mm to 50 mm
range to increase availability.

Diffuse reflectance PF minimum

1.8 %
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Table 15.4: Protective field range
Device range S M L XL
Resolution [mm] Protective field range [m]
150 3.00 4.50 6.25 8.25
70 3.00 4.50 6.25 8.25
60 3.00 4.50 6.25 8.25
50 3.00 4.50 6.25 6.25
40 3.00 4.50 4.50 4.50
30 3.00 3.50 3.50 3.50
Table 15.5: Warning field data

Number of field pairs

1,10, 10 + 10, 100

Warning field range

0-20m

Object size 150 mm x 150 mm
Diffuse reflectance WF minimum Min. 10 %
Table 15.6: Measurement field data
Detection range 0-50m
Diffuse reflectance 20 %
Radial resolution 5 mm
Lateral resolution 0.1°

Table 15.7: Electrical supply

Voltage supply
Power supply unit

24V DC (+20 % / -30 %)

Supply acc. to IEC 742 with secure mains supply
isolation and equalization for voltage dips of up to
20 ms acc. to EN 61496-1.

Voltage supply
Battery

24V DC (+20 % / -30 %)
(performance data may differ)

Overcurrent protection

Via 2 A semi-time-lag fuse in the cabinet
Notice: With high external loads at the switching
outputs (total current > 700 mA), the fuse rating
must be adjusted to 2.5 A.

Current consumption

Approx. 700 mA (use power supply unit with 3 A)

Power consumption

17 W with 24 V plus output capability

Overvoltage protection

Overvoltage protection with protected limit stop

Protective conductor

Connection required

Device connection

Connection cable, M12-8 connector

Connection socket for Ethernet/communication

M12-4 connector, D-coded
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Table 15.8: Inputs

Reset

+24 V, dynamically monitored (0.12 s to 4 s)

Signal definition:

High/logical 1 16-30V
Low/logical 0 <3V
Table 15.9: Safety-related switching outputs
OSSD transistor safety-related switching outputs 2 safe PNP semiconductor outputs
Short-circuit proof, cross circuit monitored
Minimum Typical Maximum
Response time 80 ms 1000 ms
(2 scans) (25 scans)
Switching voltage high active U, -32V
Switching voltage low 20V
Switching current 300 mA
Cut-off frequency f, 1 kHz
Load capacity C,.q 100 nF
Cable length between safety sensor and load with 25m
cross section 0.25 mm?
Permitted wire cross section 0.25 mm?
Test pulse width 60 us 110 us
Test pulse distance 35 ms 40 ms 40 ms

O  The safety-related transistor outputs perform the spark extinction. With transistor outputs, it is
IL therefore neither necessary nor permitted to use the spark extinction circuits recommended by
contactor or valve manufacturers (RC elements, varistors or recovery diodes), since these con-
siderably extend the decay times of inductive switching elements.

Table 15.10:  Inputs and outputs
Features Max. output cur- | Min. input cur- | Typical connection
rent |, rent I, components
EX/A=changeover-capable 20 mA 10 mA Auxiliary contact of
(EA1) (-20 mA) (-10 mA) power contactor
(EDM)
AX=output 100 mA -—- Lamp (PNP only)
Current limited, short-circuit proof (-20 mA) Control input (PNP/
(A1, MELD) NPN)
Signal definition:
High/logical 1 16-30V
Low/logical 0 <3V
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Table 15.11:  Software

Configuration and diagnostics software

Sensor Studio for Windows 7 and Windows 8.1

Table 15.12:  General system data

Degree of protection

IP 65 in acc. with IEC 60529

Safety class

Ambient temperature, operation

0..+50°C

Ambient temperature, storage

-20 ... +60 °C

Humidity

DIN 40040, table 10, code letter E (reasonably
dry)

Interference rejection

In acc. with DIN EN 61496-1 (type 4), also in acc.
with DIN 40839-1/3 test pulses 1, 2, 3a, 3b and 5

Vibration stress over 3 axes

In acc. with IEC 60068 part 2 - 6, 10 - 150 Hz
max 5 G

Continuous shock over 3 axes

In acc. with IEC 60068 part 2 - 29, 10G, 16ms

Disposal

Specialist disposal required

Housing

Diecast zinc, plastic

Standard version dimensions (ensure free space for
plug with fixing and connection cable)

140 x 149 x 140 (W x H x D) in mm

Weight of standard version incl. connection unit

Approx. 3 kg

Distance, beam level center to bottom housing edge

104 mm
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15.2 Dimensions
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Figure 15.1: Dimensions safety laser scanner with connection unit
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Figure 15.2: Mounting dimensions safety laser scanner with connection unit
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Figure 15.3: Minimum space requirements for installation and replacement of scanner unit
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1 Reference point for distance measurement and protective field radius

Figure 15.4: Dimensions of scanning range
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15.3 Dimensioned drawings: Accessories
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Figure 15.5: Mounting system BTUS800M
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Figure 15.6: Mounting bracket BTF815M
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Figure 15.7:  Mounting bracket BTF830M
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160

169

all dimensions in mm
Figure 15.8: Loop guard BTP800M
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all dimensions in mm
Figure 15.9:  Mounting bracket BT840M
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Figure 15.10: Mounting bracket BT840M, view A
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Figure 15.11: Mounting bracket BT856M
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Figure 15.12: Mounting bracket BT856M, view A
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Figure 15.13: Drilling template for adapter plate, RS4/ROD4 BT800MA
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15.4
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The mounting plate BTU804MA supplements the old mounting system of the RS4/ROD4 for the

mounting system BTU8S00M.
Figure 15.14: Mounting plate BTU804MA

Representation of safety sensor status

The table lists all logic and electrical signals that are present in the safety sensor. The signal names are
used consistently throughout the configuration and diagnostics software (device DTM), in the event log
and in the data telegram.

Table 15.13:  Representation of status

Byte |Bit | Signal Description Value “0” | Value “T” | Default

0 --- - Type (variant) of status profile. | --- - 1
Extensions require new type of
status profile

1 - OP-MODE Operating mode: - 1
» 1: Safety mode
+ 2: Simulation mode

Messages and OSSDs
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Byte Bit Signal Description Value “0” | Value “T” | Default
2 7 ERROR Collective message: Off Message | 0
Error with switch-off
6 ALARM Collective message: Off Message | O
Warnings with switch-off (also
window warning)
5 SCREEN Contamination display for Off Message | 0
optics cover
Warning and switch-off
4 EDM EDM collection error Off Message | ---
3 FIELD PAIR Collective message: Off Message | ---
Fault detected by field pair
selection monitoring
2 E-STOP Error with OSSD linkage / E- Off Message | ---
Stop monitoring
1 A-OSSD OSSD state Off On 0
Protective function A
0 B-OSSD OSSD state Off On 0
Protective function B
E-Stop, parking and reflectors
3 7 Status-Input-SE Status of the inputs SE1 and Off On 0
SE2
E-Stop
6 Mode-PARK Park request fulfilled Off Parked 0
5 RFL-SEG-1 Reflector area 1 Off Reflector | 0
detected
4 RFL-SEG-2 Reflector area 2 Off Reflector | ---
detected
3 RFL-SEG-3 Reflector area 3 Off Reflector | ---
detected
2 RFL-SEG-4 Reflector area 4 Off Reflector | ---
detected
1 reserved -—- - - -
0 reserved --- -

Electrical signals at sensor connection
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Byte Bit Signal Description Value “0” | Value “T” | Default
4 7 F1 Control input - - 0
Input group 0
6 F2 Control input — 0
Input group 0
5 F3 Control input - - 0
Input group 0
4 F4 Control input - - —
Input group 0
3 F5 Control input -
Input group 0
2 F6 Control input -—- — —
Input group 1
1 F7 Control input -
Input group 1
0 F8 Control input - - -
Input group 1
5 7 F9 Control input - 0
Input group 1
6 F10 Control input --- - 0
Input group 1
5 RES1 Start input - 0
Protective function A
4 RES2 Start input - - —
Protective function B
3 EA1 EDM input -
Protective function A
2 EA2 EDM input -
Protective function B
1 EA3 -
0 EA4 -
6 7 SE1 Linkage input - - 0
6 SE2 Linkage input --- - 0
5 PNP-NPN PNP/NPN changeover npn pnp 0
4 A1 Output - - —
3 A2 Output - - -
2 A3 Output - - —
1 A4 Output - - -
0 MELD Output - - —
7 reserved - -
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Byte Bit Signal Description Value “0” | Value “T” | Default
8-11 31-0 | SCAN Consecutive numbering of - - Value
uint32 scans

Resetting to 0 by switching off

Protective function A

12 7 A-ACTIVE Protective function A is active / | Off Active 0

configured

6 A-WF-VIO Status of active warning field Violation | Free 0
Protective function A

5 A-PF-VIO Status of active protective field | Violation | Free 0
Protective function A

4 A-RES Start/restart interlock active Off Active 0
Start Request A

3 A-CLEAR Internal signal OSSD A Off On 0

2 reserved --- - - -

1 reserved -—- -

0 reserved --- -

Field pair selection A

13 7-4 | A-BANK-SEL Selected bank A --- 0
Numbers 1 ... 10

3-0 | A-PAIR-SEL 1 First selected field pair A -—- 0
Numbers 1 ... 10

14 7-4 | A-PAIR-SEL 2 Second selected field pair A - - 0
Numbers 1 ... 10

3-0 | A-PAIR-SEL 3 Third selected field pair A - 0
Numbers 1 ... 10

Output signals A
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Byte Bit Signal Description Value “0” | Value “T” | Default
15 7 A-WF-VIO-SEG-1 | Status of active warning field Violation | Free 0

segment
Protective function A

6 A-WF-VIO-SEG-2 | Status of active warning field Violation | Free 0
segment
Protective function A

5 A-PF-VIO-SEG-1 Status of active protective field | Violation | Free 0
segment
Protective function A

4 A-PF-VIO-SEG-2 | Status of active protective field | Violation | Free 0
segment
Protective function A

3 A-FP-SEL-1 Defined field pair selected Off Selected | 0
Protective function A

2 A-FP-SEL-2 Defined field pair selected Off Selected |0
Protective function A

1 reserved -—- -

0 reserved --- -
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16  Standards and legal regulations
The following national and international legal regulations apply for start-up, technical tests and handling of
safety sensors:
» Machinery directive 2006/42/EC [1]
» Low voltage directive 2006/95/EC [2]
+ Electromagnetic compatibility 2004/108/EC [3]
» Use of Work Equipment Directive 89/655/EEC supplemented by Directive 95/63 EC [4]
» Hazardous substances 2002/95/EC
* OSHA 1910 Subpart O [5]
+ Vibration EN 60068-2-6 [19]
» Eye safety (measurement laser) EN 60825-1 [20]
« Safety regulations
» Accident-prevention regulations and safety rules [6]

+ Betriebssicherheitsverordnung (Ordinance on Industrial Safety and Health) and employment protec-
tion act [7]
* Product Safety Law (ProdSG) [8]
+ Standards for risk assessment, e.qg.
+ ENISO 12100 [9]
+ ENISO 13849-1, -2 + Ber.1:2009 [10]
+ IEC 61508-1 to -7 [11]

+ ENIEC 62061 [12]
+ ENIEC 60204 [18]

- EN ISO 13849-1:200 [13]
- EN ISO 13855:2010 [14]
- EN/IEC 61496-3 [15]

- EN 1525 [16]

- EN 999 [21]

« IEC/TS 62046:2008 [17]
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17  Ordering information and accessories

Scope of delivery

+ 1 self-adhesive notice sign “Important notices and notices for the machine operator”
+ 1 original operating instructions “Safe implementation and operation” (PDF file on data carrier)
* 1 print document “Quick Start Guide RSL 400"

Table 17.1: Part numbers

Part no.

Article

Description

53800201

RSL410-S/CU408-M12

1 OSSD pair; 1 field pair; 3 10s; short range
Connection: M12, 8-pin
Ethernet: M12, 4-pin

53800202

RSL410-M/CU408-M12

1 OSSD pair; 1 field pair; 3 10s; medium range
Connection: M12, 8-pin
Ethernet: M12, 4-pin

53800203

RSL410-L/CU408-M12

1 OSSD pair; 1 field pair; 3 10s; long range
Connection: M12, 8-pin
Ethernet: M12, 4-pin

53800204

RSL410-XL/CU408-
M12

1 OSSD pair; 1 field pair; 3 10s; extra long range
Connection: M12, 8-pin
Ethernet: M12, 4-pin

53800245

RSL410-S/CU411-RS4

1 OSSD pair; 1 field pair; 3 10s; short range; RS4 adapter
Connection: cable, 11-wire, length 6 m, SUB-D 15
Ethernet: M12, 4-pin

53800246

RSL410-M/CU411-RS4

1 OSSD pair; 1 field pair; 3 10s; medium range; RS4
adapter

Connection: cable, 11-wire, length 6 m, SUB-D 15
Ethernet: M12, 4-pin

53800247

RSL410-L/CU411-RS4

1 OSSD pair; 1 field pair; 3 10s; long range; RS4 adapter
Connection: cable, 11-wire, length 6 m, SUB-D 15
Ethernet: M12, 4-pin

Table 17.2: Components

Part no. Article Description
Scanner units
53800101 RSL410-S 1 OSSD pair; 1 field pair; 3 I10s; short range
53800105 RSL410-M 1 OSSD pair; 1 field pair; 3 10s; medium range
53800109 RSL410-L 1 OSSD pair; 1 field pair; 3 10s; long range
53800113 RSL410-XL 1 OSSD pair; 1 field pair; 3 10s; extra long range
Connection units
53800117 CU408-M12 Connection: M12, 8-pin

Ethernet: M12, 4-pin
53800125 CU411-RS4 RS4 adapter

Connection: cable, 11-wire, SUB-D 15, length: 6 m
Ethernet: M12, 4-pin
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Table 17.3: Accessories

Part no. Article Description

Mounting technology

53800130 BTU8SOOM Laser scanner mounting system for vertical and horizontal
alignment

53800132 BTF815M Mounting bracket for floor mounting; scanning height
150 mm
Mounting of safety sensor only in combination with
BTU8OOM

53800133 BTF830M Mounting bracket for floor mounting; scanning height
300 mm
Mounting of safety sensor only in combination with
BTU8S0OOM

53800134 BT840M Mounting bracket for corner mounting on posts (cham-
fered corner)
direct mounting of the safety sensor

53800135 BT856M Mounting bracket for corner mounting on posts
direct mounting of the safety sensor

53800131 BTP800OM Loop guard for optics cover
Only in combination with BTU8S800M

53800136 BTU804MA Mounting plate for mounting system RS4 / ROD4

53800137 BT800MA Drilling template for adapter plate, RS4/ROD4

Cleaning fluids

430400 Cleaning set 1 Cleaning fluid for plastic, 150 ml, cleaning cloths, 25x,
soft, fuzz-free

430410 Cleaning set 2 Cleaning fluid for plastic, 1,000 ml, cleaning cloths, 100x,
soft, fuzz-free
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18  EC Declaration of Conformity

EG-KONFORMITATS-
ERKLARUNG
(ORIGINAL)

& Leuze electronic

EC DECLARATION OF
CONFORMITY
(ORIGINAL)

the sensor people

DECLARATION CE DE
CONFORMITE
(ORIGINAL)

Der Hersteller

The Manufacturer

Le constructeur

erklart, dass die nachfolgend
aufgefiihrten Produkte  den
einschlagigen Anforderungen der
genannten EG-Richtlinien und
Normen entsprechen.

Leuze electronic GmbH + Co. KG
In der Braike 1, PO Box 1111
73277 Owen, Germany
declares that the following listed
products  fulfil the relevant
provisions of the mentioned EC

Directives and standards.

déclare que les produits identifiés
suivants sont conformes aux
directives CE et normes
mentionnées.

Produktbeschreibung:

Description of product:

Description de produit:

Sicherheits-Laserscanner fiir
Personenschutz,
Beriihrungslos wirkende
Schutzeinrichtung,
Sicherheitsbauteil nach 2006/42/EG
Anhang IV
RSL 400
Seriennummer siehe Typschild

Safety Laser Scanner for
personnel protection,
Active opto-electronic protective
device,
safety component in acc. with
2006/42/EC annex IV
RSL 400
Serial no. see name plates

Scanner laser de sécurité pour la
. protection des personnes,
Equipement de protection électro-
X sensible,
Elément de sécurité selon
2006/42/CE annexe IV
RSL 400
N° série voir plaques
signalétiques

Angewandte EG-Richtlinie(n):

Applied EC Directive(s):

Directive(s) CE appliquées:

2006/42/EG
2004/108/EG

2006/42/EC
2004/108/EC

2006/42/CE
2004/108/CE

Angewandte Normen:

Applied standards:

Normes appliquées:

EN 61496-1:2012; IEC 61496-3:2008; EN ISO 13849-1:2008 (Kat 3, PLd);
EN 62061:2005 (SIL 2); EN 60825-1:2007;

IEC 61508:2010 Part 1-4 (SIL2)
EN 55022:2003

Benannte Stelle /
Baumusterpriifbescheinigung:

Notified Body /
Certificate of Type Examination:

Organisme notifié /

Attestation d'examen CE de type:

TUV-sUD PRODUCT SERVICE GmbH

Zertifizierungsstelle
Ridlerstrafe 65
D-80339 Miinchen

Bevollmachtigter fur die
Zusammenstellung der
technischen Unterlagen:

Authorized person to compile the

technical file:

Personne autorisée a constituer
le dossier technique:

André Thieme; Leuze electronic GmbH + Co. KG
Liebigstr. 4; 82256 Fuerstenfeldbruck; Germany

Owen, 16.12.2014
Datum / Date / Date

Leuze electronic GmbH + Co. KG, Sitz Owen | Registergericht Stuttgart, HRA 230712
Libi

4, D-82256 Fii

ich haftende i

Leuze electronic Geschaftsfiihrungs-GmbH, Sitz Owen | Registergericht Stuttgart, HRB 230550

Geschftsfiihrer: Ulrich Balbach
USt.IdNr. DE145912521 | Zolinummer 2554232

Es gelten ausschlieBlich unsere aktuellen Verkaufs- und Lieferbedingungen.

s

Ulri albaré%irgeschéftsfuhrerl Director / Ditg

| T +49 8141 5350-0, F +49 8141 5350-190 | info@leuze.de, www.leuze.de

—

BUSINESS

Leuze electronic

RSL 410

108



	1 About this document
	1.1 Other applicable documents
	1.2 Downloading configuration software from Internet
	1.3 Used symbols and signal words
	1.4 Checklists

	2 Safety
	2.1 Approved purpose
	2.1.1 Vapors, smoke, dust, particles
	2.1.2 Stray light
	2.1.3 Obstructions in the protective field

	2.2 Foreseeable misuse
	2.3 Responsibility for safety
	2.4 Competent persons
	2.5 Exemption of liability
	2.6 Laser safety notices – Laser class 1 for wavelength range outside 400 - 700 nm

	3 Device description
	3.1 Device overview
	3.1.1 Protective function of RSL 400 safety sensors
	3.1.2 Parameters for protective function

	3.2 Connection unit
	3.3 Display elements
	3.3.1 LED indicators
	3.3.2 Alphanumerical display
	3.3.3 Field-of-view display

	3.4 Mounting system (optional)
	3.5 Loop guard (optional)

	4 Configuration and diagnostic software Sensor Studio
	4.1 System requirements
	4.2 Installing software
	4.3 User interface
	4.4 FDT frame menu
	4.4.1 Project Wizard
	4.4.2 DTM Change
	4.4.3 User management
	4.4.4 Exiting Sensor Studio

	4.5 Using configuration projects
	4.5.1 Selecting access level
	4.5.2 IDENTIFICATION
	4.5.3 PROCESS
	4.5.4 CONFIGURATION
	4.5.5 DIAGNOSIS
	4.5.6 SETTINGS


	5 Functions
	5.1 Authorization concept of safety sensor
	5.2 Function modes of safety sensor
	5.2.1 One protective function
	5.2.2 One protective function - four field mode

	5.3 Selectable resolution for hand, leg and body detection
	5.4 Speed-dependent protective function for vehicles
	5.5 Response time
	5.6 Configurable start-up behavior
	5.6.1 Automatic start/restart
	5.6.2 Start interlock/automatic restart
	5.6.3 Start/restart interlock (RES)

	5.7 Reference contour monitoring
	5.8 EDM contactor monitoring

	6 Applications
	6.1 Stationary danger zone guarding
	6.2 Stationary point of operation guarding
	6.3 Stationary access guarding
	6.4 Mobile danger zone guarding
	6.5 Danger zone guarding on side-tracking skates

	7 Mounting
	7.1 Basic infos
	7.1.1 Calculation of safety distance S
	7.1.2 Suitable mounting locations
	7.1.3 Mounting the safety sensor
	7.1.4 Mounting examples
	7.1.5 Information on protective field dimensioning

	7.2 Stationary danger zone guarding
	7.3 Stationary point of operation guarding
	7.4 Stationary access guarding
	7.5 Mobile danger zone guarding on DTSs
	7.5.1 Minimum distance D
	7.5.2 Protective field dimensions

	7.6 Mobile side guarding on DTSs
	7.7 Mounting accessories
	7.7.1 Mounting system
	7.7.2 Loop guard


	8 Electrical connection
	8.1 Electrical supply
	8.2 Interfaces
	8.2.1 Pin assignment for control M12
	8.2.2 Pin assignment of M12 Ethernet interface (communication) ( D-coded)

	8.3 Connection unit CU408-M12
	8.4 Circuit diagram example

	9 Configuring the safety sensor
	9.1 Defining safety configuration
	9.2 Connecting safety sensor to PC
	9.2.1 Connection via Ethernet cable
	9.2.2 Connection via Bluetooth
	9.2.3 Communication between safety sensor and PC

	9.3 Determining configuration project
	9.4 Configuring protective function
	9.4.1 Creating simple safety configuration
	9.4.2 Entering administration parameters
	9.4.3 Activating protective function and contactor monitoring
	9.4.4 Creating and configuring protective/warning field pairs

	9.5 Saving configuration
	9.6 Transferring configuration project to safety sensor
	9.7 Selecting access level
	9.8 Reset safety configuration

	10 Starting up the device
	10.1 Switching on
	10.2 Aligning the safety sensor
	10.3 Unlocking start/restart interlock
	10.4 Shutting down
	10.5 Restarting
	10.6 Starting up replacement scanner unit

	11 Testing
	11.1 Before the initial start-up and following modifications
	11.1.1 Checklist for integrator – to be performed prior to the initial start-up and following modifications

	11.2 To be performed periodically by competent persons
	11.3 Periodically by the operator
	11.3.1 Checklist – periodically by the operator


	12 Diagnostics and troubleshooting
	12.1 What to do in case of failure?
	12.2 Diagnostics displays

	13 Care, maintenance and disposal
	13.1 Changing scanner unit
	13.2 Cleaning the optics cover
	13.3 Servicing
	13.4 Disposing

	14 Service and support
	15 Technical data
	15.1 General specifications
	15.2 Dimensions
	15.3 Dimensioned drawings: Accessories
	15.4 Representation of safety sensor status

	16 Standards and legal regulations
	17 Ordering information and accessories
	18 EC Declaration of Conformity

